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Introduccion a Visual C++ Builder de Embarcadero RAD Studio XE series

Introduccion:

Embarcadero (Borland) Rad Studio C++ Builder es un IDE que permite utilizar la programacién orientada a objetos
utilizando como base el lenguaje C++ en modo visual. Aunque también permite hacer aplicaciones C++ de consola.
Este IDE comparte las mismas funciones vy librerias basicas, llamadas VCL que Delphi, lenguaje basado en lenguaje
Pascal orientado a objetos.

e Para crear un proyecto en modo visual orientado a objetos escoger del mend: New — Project o New - VCL Form
Application para emplear las librerias VCL para Windows. Las versiones XE incorporan la variante Firemonkey que
permite compilar en multiplataforma OS — Android e incluso dispositivos moviles.

e Para un archivo Cpp en modo consola, escoger: New — Other — Console application. Puedes escoger el lenguaje C o
C++

Conceptos basicos.

= Proyecto. Un proyecto es un conjunto de mddulos de formulario, de cédigos y de archivos que componen
una aplicacion. Los archivos que componen la aplicacién se ven en la ventana View » Project Manager.

= Formulario. Ventana donde se incluye los controles y el cédigo asociado a dicho formulario.

= Componentes o controles. Los componentes son herramientas como cuadros, botones y etiquetas que se
disponen en un formulario para permitir la entrada de datos o para presentar resultados

= Objetos y Clases: Un objeto es la instancia de un componente que pertenece a un tipo o clase determinada

= Propiedades. Usando la ventana de Object inspector (F11) se definen las propiedades de formularios y
controles. Las propiedades especifican los valores iniciales de las caracteristicas, tales como tamafio,
nombre y posicion. Yambién llamados atributos del objeto.

= Eventos: Es quien desencadena las acciones del sistema. También llamados métodos.

Concepto de cédigo:

Es el texto escrito en un programa que realizard una accion. Estas acciones pueden ser simples subrutinas ,

procedimientos o funciones segun su complejidad.

= Acciones o subrutinas: Trozos de c4digo como respuesta a un evento o accién. No recogen ni devuelven
ningun valor.

= Procedimientos: Acciones que recogen o utilizan unos parametros de entrada pero no devuelven ningin
valor.

= Funciones: Son procedimientos que recogen valores de entrada y ademas devuelve un valor de salida al
procedimiento desde donde se le llam6

= Diagrama de Flujo: Representa la esquematizacion grafica de un algoritmo, el cual muestra graficamente
los pasos 0 procesos a seguir para estructurar bien un programa.

Reglas de nomenclatura al declarar procedimientos o variables:

= Deben comenzar por una letra. Distingue mayudsculas y minusculas.
= No pueden contener puntos.
= No pueden superar los 255 caracteres

= Nombres de formularios no sobrepasar 40 caracteres Propiedades basicas de los objetos:
* No pueden tener el mismo nombre que una palabra clave Alignm. ent - Alineacion
= Comentarios en el cddigo se inician con: // o entre /* */ Bevellnner - borde interior
BorderStyle - estilo del borde
Caption - rétulo
Eventos o acciones (sobre un componente): TabStop - Salto tabulacion
Lista de eventos (Acciones sobre los controles) Color, Cursor - Color, puntero
Enabled - Activo
Evento Accion Font - Tipo letra
Click Al hacer clic con el mouse (o el teclado) Height - Altura del objeto
DragDrop Al soltar un control arrastrado con el mouse Hint - Etiqueta ayuda
DragOver Al Arrastrar un control con el mouse. Left - Posicion izquierda
KeyDown Presionar una tecla mientras el objeto tiene el foco. Name - Nombre del objeto
KeyPress Presionar una tecla y devolver su valor ASCII. PopupMenu - Menu contextual
KeyUp Liberar una tecla mientras el objeto tiene el foco. ShowHint - Mostrar etiquetas
MouseDown Presionar el botén del mouse sobre el objeto. Top - Posicion superior
MouseMove Mover el puntero del mouse por encima del objeto Visible - Visible
MouseUp Liberar el botén del mouse en el objeto. Width - Ancho del objeto
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Lenguaje base

Estructuras de control Operadores

= if (comparador si-entonces) = = (asignacion)

= if...else (comparador si...sino) = +(suma)

= for (bucle con contador) = - (resta)

= switch / case (comparador miltiple) = * (multiplicacién)

= while (bucle por comparacion booleana) = /(division)

= do... while (bucle por comparacién booleana) = 9% (resto)

= break (salida de bloque de cédigo) = == (igual a)

= continue (continuacién en bloque de cédigo) = = (distinto de)

= return (devuelve valor al programa principal) = < (menor que)

Tipos = > (mayor que)

= boolean (booleano) = <=(menor oigual que)
= char (caracter) = >=(mayor o igual que)
= byte (entero hasta 226) = && (y) [l (o)

* int (entero) = I (negacién)

= unsigned int (entero sin signo) = ++ (incrementa) -- (decrementa)
= long (entero 32b) Matematicas

= unsigned long (entero 32b sin signo) = min () (minimo)

= float (decimal de coma flotante de 16b) = max () (maximo)

= double (decimal coma flotante de 32b) = abs () (valor absoluto)

= string (cadena de caracteres) = sq () (eleva al cuadrado)
= array (cadena matriz) = sqrt () (raiz cuadrada)

= void (vacio) = sin() (seno) cos () (coseno)

= tan () (tangente)
Conversion de tipos:

IntToStr (Integer to String) » Cambia del tipo de nimero entero a cadena de texto
StrTolnt (String to Integer) » Cambia del tipo cadena de texto a niUmero entero

Otros:
StrToFloat (texto a decimal flotante) DateTimeToStr (Fecha/hora a texto)
FloatToStr (Decimal flotante a texto)) DateToStr (Fecha a Texto)
FloatToDecimal (Decimal flotante a decimal StrToTime (Texto a hora)
Formatfloat (Decimal flotante a texto con formato) StrToDate (Texto a fecha)
Bucles:

Infinitos: While: Repite la ejecucion infinitas veces mientras se cumpla la condicion.
Finitos (Contadores): For ..., Repite la ejecucion un nimero determinado de veces

Ventanas de mensaje. (Mostrar o pedir mensajes al usuario):

= Usando las funciones VCL internas que incorpora C++Builder:
- ShowMessage(): Muestra un mensaje de texto en una ventana
- MessageDlg(): Muestra una ventana con mensaje y botones de respuesta
Los botones de accidén pueden ser: mbOK — mbCancel — mbYes — mbNo — mbAbort — mbRetry — mbClose
Y sus repuestas son: mrOk - mrCancel — mrYes — mrNo — mrAbort — mrRetry - mrClose
- MessageDIgPos() idem pero con posibilidades extras
= Usando las funciones de la APl de Windows
- Application->MessageBox(): Muestra un mensaje de texto en una ventana de Windows estandar con o sin botones
de respuesta que pueden ser: MB_OK - MB_OKCANCEL- MB_ABORTRETRYIGNORE - MB_YESNOCANCEL -
MB_YESNO -MB_RETRYCANCEL - MB_HELP
= Creando nuestros propios formularios/ventanas:
- Primero: crear un nuevo formulario secundario: Flie — New — Form donde se pondra el mensaje y los botones
- Segundo: incluir la unidad cabecera de este formulario en la principal: #include "secundario.h"
- Tercero: Mostrar la ventana utilizando las funciones show() o showmodal();
Pedir datos al usuario en ventanas:
= Utilizando ventanas con entradas de texto:
- InputBox('Nombre_ventana', 'Texto_Dato', 'Respuesta_predeterminada'); = Devuelve Var String
- InputQuery('ldentificate!', 'Pon tu nombre, por favor...", Nombre); = Devuelve Var Bolean
= Afladiendo componentes de didlogo estdndar al formulario desde la paleta Dialogs:
- Opendialog — Savedialog: Componentes para abrir y guardar archivos
- PrintDialog — PrinterSetupDialog - PageSetupDialog: Componentes para imprimir y configurar impresién
- FontDialog — ColorDialog - FindDialog: Cambiar la fuente, el color o buscar texto.
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Cuadros de didlogo MessageBox.
Puedes hacer llamadas a cuadros de didlogo de la APl de Windows usando: Application->MessageBox
Si afiades la linea:

Application->MessageBox(L"¢Desea continuar?", L"Pregunta"”, MB_OKCANCEL); //con L si es Unicode
Application->MessageBox("¢Desea continuar?"”, "Pregunta"”, MB_OKCANCEL); //sin L si no es Unicode
Dispones de las variantes: MB_OK - MB_OKCANCEL- MB_ABORTRETRYIGNORE- MB_YESNOCANCEL- MB_YESNO-
MB_RETRYCANCEL- MB_HELP
Ejercicio 1:
= Crear una nueva aplicacién VCL (libreria visual C para Windows) escogiendo del menu: File » New » VCL Form Applicaton
C++ Builder.

= En un formulario nuevo, desde la Tool palette, afiade un 0 Form1 = = =
componente TButton (botén Buttonl). Desde el panel de |:::: i :::i:: i
propiedades, cambia su propiedad Caption por: Aceptar A
-Pulsadobleclicsobreelboténeintroduceelcédigo(enel R S
evento OnClic del botén Button1) por: S T -Vo Yy v - N
::::::::::::::?....?...;X:::::::::::::

void _ fastcall TForml::ButtoniClick(TObject *Sender) Cooiooooioiooioooioror Name: Buttonl o

{ Cloloiliiioiiiiiiiiiis Caption: Aceptar |

Buttonl->Caption="Vale"; L

ShowMessage("Hola mundo");
¥
(Importante escribir “Button” con la 12 letra en mayusculas, ya que C++ distingue mayusculas de minudsculas)

= Prueba la aplicacién pulsando en Run ».

= Si funciona correctamente, guarda la aplicacién: File » Save all . El archivo de proyecto se llamara ClaseOcpp.

Ejercicio 2:

Abre el proyecto anterior ClaseOcpp.

= Desde la Tool palette, afiade al ejercicio anterior un
componente TEdit y un componente TLabel con las propiedades
de la imagen:

= Cambiar el evento: OnClick del botdon Button1 por:
void _ fastcall TForml::ButtonlClick(TObject *Sender)

{
ShowMessage("Hola, " + Editl->Text); L \\ :
} . Name: Label1 e D . [

ShowMessage: funcién para mostrar una ventana de mensaje - Caption: Mombre: == -0

Mejoras: Utilizar una variable de texto: String mensaje = "Hola" R
y mostrar el mensaje: ShowMessage(mensaje);

Guarda el proyecto con el nombre: ClaseunoCpp
Ejercicio 2b. Pide el PIN:
e Cambia la propiedad Labell.Caption="Pin: ” if (Editl->Text=="123") ShowMessage("Bien");
e Cambia el Cédigo en el evento Button1Click: — else  Shoutessage("Mal");

void _ fastcall TForml::ButtonlClick(TObject *Sender)

¥
Variante 3: Al pulsa Intro:
Al pulsar Intro en el Editl comprueba si lo escrito es void _ fastcall TForml::EditlKeyUp(..
correcto utilizando la funcién key: — { int numero; //creamos una variable tipo entero

if (Key==13) { numero=(StrToInt(Editl->Text));

e Cambia el Codigo en el evento EditiKeyUp: — if (numero==555) ShowMessage("bien");

Y}

Ejercicio 3. Contador:

StrTolnt y InttoStr: Son funciones que convierten un valor de numérico entero (Integer) a texto (String) y viceversa

= Recupera el ejercicio anterior.

= Cambia el texto (propiedad caption) del botén por: 0

= Afiade un segundo botén a la ventana formulario desde la paleta
Tool palette — seccién Standard: Tbutton
Al botdn 2 cambia el texto (propiedad caption) por Contar
Pulsa doble clic encima de él, para abrir la ventana de cddigo.

Entre las llaves { } debes escribir el cédigo:
Buttonl->Caption= Buttonl->Caption +1;

Si lo ejecutas (run), veras cuenta mal porque afade la letra 1 pero no suma el niimero 1

Para ello hay que convertir las letras en niUmeros enteros: string to integer o abreviado: StrToint
Buttonl->Caption = StrToInt(Buttonl->Caption) +1; // Si ahora lo ejecutas, verds que ya funciona.

= Si funciona correctamente, guarda la aplicacién: File — Save Project as.. El archivo de proyecto se llamara Contador.
El archivo unidad se llamara: Contadorl.cpp, el proyecto Contador.cbproj y su archivo cabezera ContadorCH1.h
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Ejercicio. Adivina el numero.
= Crear una nueva aplicacién VCL escogiendo del menu: File - New — VCL Form Applicaton C++ Builder.
® En el formulario nuevo, desde la Tool palette, afiade los siguientes
Ingredientes: * Adivina un nimero def 03l 100 en tres ntentaos
2 Labels A - 1Edit[al] - 1 Button 2t I o oa e e 0o
Preparacion: e e e eenen
Creamos 2 variables publicas: Bueno: integer y Intentos: integer: co s |Edit sooccons
#include <vcl.h> oo cccaooanae ..:::::é;ﬁﬁal """

#pragma hdrstop il

#include "Unitl.h" SRR T
#pragma package(smart_init) L Y
#pragma resource "*.dfm"

TForml *Forml;

int bueno, intentos;

Coccion:
Al crearse el formulario se genera un nimero aleatorio del 1 al 100 y se guarda en la variable bueno:

void _ fastcall TForml::FormCreate(TObject *Sender)

{
Randomize();
bueno=random(100) ;
intentos=0;

}

Acciones: Al pulsar el botén, se crea una variable numerousuario y se evalla si la variable es igual o mayor a la

variable bueno:

void _ fastcall TForml::ButtonlClick(TObject *Sender)
{

int numerousuario;

numerousuario = StrToInt(Editl->Text);

if (numerousuario==bueno) {
ShowMessage("Acertaste");

}

else

{
1}

ShowMessage("Fallaste, el numero era el " + IntToStr(bueno));

Mejoras:
Mejora 12: Consigue que el programa te informe si el nUmero introducido es mayor o menor

void _ fastcall TForml::ButtonlClick(TObject *Sender)
{
int numerousuario;
numerousuario = StrToInt(Editl->Text);
if (numerousuario==bueno) {
ShowMessage("Acertaste");
}
else
{
if (numerousuario>bueno) {
ShowMessage("Fallaste, el numero es mas pequefio");
}
else
{
ShowMessage("Fallaste, el numero es mas grande");
}
1}

Mejora 22:
e Afadir una barra de progreso: progressbarl =1 (paleta win32) Progressbar: Max: 60 Position: 60

e Afadir un Temporizador: Timer (paleta system) Interval: 1000 (Repetira el evento cada 1 segundo)

En el evento del timer OnTimer afiadir el cddigo para evaluar el tiempo tardado en acertar y decrementar la barra de

progreso. if (ProgressBar1->Position=0) {Showmessage('Se acabd el tiempo'); Timerl->enabled:=false;}
Mejora 32:
Al pulsar la tecla Enter en el Edit1 (Edit1KeyPress), llama a la funcidén ButtoniClick:

if (Key==13) ButtonlClick(Sender); o if (Key==13) Buttonl->SetFocus(); //Buttonl recibe el foco

Guardar: Guarda la aplicacion (Save all).
La unidad con el nombre: adivinanzal.cpp y el proyecto con el nombre: adivinanza.cproj
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Uso del Timer y posicion del objeto:

= Crea una nueva aplicacidn VCL (libreria visual) escogiendo del menu: File - New — VCL Form Applicaton C++ Builder.
= Afiade un botén Buttonl en un formulario nuevo. Cambiar su propiedad Caption por: Pulsame.

= En el evento del boton OnMouseMove:

void __fastcall TForm6::Button1MouseMove(TObject *Sender, TShiftState Shift, int X, intY)

{ Buttonl->Left = Buttonl->Left + 1; }

Ejecuta y prueba (Run): Al intentar pulsar el botdn, este se desplaza hacia la derecha.

= Anula esta ultima linea de cddigo convirtiéndola en un comentario: afiade // delante

= Afiade un componente Ttimer de |la paleta System.
Poner su propiedad Interval a 10 y si propiedad enableden - -

False: i
En el evento del botén OnClick:

TButton

void __fastcall TForm6::Button1Click(TObject *Sender) ~ ©: iiooooiioooonorno =l P ulsame |
{ Timerl->Enabled = True; ¥ D
En el evento del Timer OnTimer: A
void __fastcall TForm6::Timer1Timer(TObject *Sender) [l il :*'L"J: Y
{ Buttonl->Left = Buttonl->Left + 1; } D Timert TTimer 1: :ﬁ'.-'*‘:: Cooiiiiiiiiiin
o [Enabled  |[]False T B
Ejecuta y prueba (Run): Al pulsar el botén, activamos el - - [Mnterval 10 SRR RS RS R
. . . .. . . |Mame Timerl
temporizador Timer que desplaza un pixel a la derecha la - - el
posicidn del botdn a cada pulso de su intervalo, de duracién 10 milisegundos.
Ejercicio ventana con barra de progreso
= Crea un nuevo proyecto: File » New » Application VCL (o VCL Forms application).
Disefio: Tt T » o
~ . . j Imer imer -
= Afiade al formulario un objeto [Properes |—¢ e Transferencia.. SR (ECR ==
barra de progreso tProgressBar IE”;':"EE: ;“'E SRR .
(de la paleta win32), dos N”amr;a T 1‘\ & oo ar _ oy
botones (tButtonS), una etiqueta Tag 5 DI Tmerll Dl Transfiriendo archivos 2 mi cuentas.. - - - - - -0 - - -

tLabel (de la paleta Standard) y |
un componente tTimer (Paleta [Propertes |ProgressBart

System) Max
= Distribuye y cambia las Mn -
. Mame ProgressBar1
propleda_des de la Vent.ana' Crientation pbHorizontal - - - -
formulario como en la imagen. Position

Eventos: (Suceso que desencadena una accién)

= Pulsa doble clic sobre el evento OnTimer del Timerl para mostrar el cédigo de su procedure y afiade:

void _ fastcall TForml::TimerlTimer(TObject *Sender)
{

ProgressBarl->Position ++; //-> incrementa la barra una posicidn

if (ProgressBarl->Position==100) { //-> si llega a 100..
Timerl->Enabled=False; // -> para el temporizador
ShowMessage("Transferencia realizada"); // -> muestra un mensaje
Application->Terminate(); //-> termina el programa

}

¥
En el evento del boton OnClick:
void __fastcall TForm6::Button1Click(TObject *Sender)
{ Timerl->Enabled = True; ki

Opcional: Puedes impedir cerrar la ventana si en el evento del form: Closequery pones la variable canClose=false;
Ejemplo: ShowMessage(“No puedes cerrar la ventana mientras se transfieren los archivos”); canClose=false;

» Probar la aplicacién: Pulsa Run [> para comprobar su funcionamiento.

= Guardar el proyecto: Crea una carpeta que se llame: Transferencia

o Escoge: File » Save as... Para guardar el archivo: Transferencial.cpp
o Escoge: File » Save project as... Para guarda el proyecto Transferencia.cbproj y Trasferenciah.hpp
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Bucles:
Inflnlt_o: int clave=5;
While: while (clave != 123)
Repite la ejecucioén infinitas veces hasta que { _ i}
se Cumpla la condicion. ) ShowMessage("incorrecto, repita la clave");
Finito (Contador):
For ... :
Ejecuta una accion un nimero determinado | for (int i=e; i < 10; i++) {
de veces. ShowMessage("Contando hasta diez: " + IntToStr(i));

}

Ejercicio while - for

Barra de Progreso con while (sin timer)
= Crea un nuevo proyecto para Windows: File » New » Windows VCL Application (C++ Builder).
Disefio:
= Afiade al formulario un objeto barra de progreso tProgressBar

= Un botén (tButton) y una etiqueta tLabel (de la paleta (@) Forma
Standard)

= Distribuye y cambia las propiedades de la ventana-
formulario como en la imagen.

Eventos: (Suceso que desencadena una accion)

= Pulsa doble clic sobre el Boton y escribe el cédigo siguiente segln la version escogida:

void _ fastcall TForml::ButtonlClick(TObject *Sender)
while (ProgressBarl->Position<100) //mientras sea menor a 100..
{
ProgressBarl->Position ++; // incrementa 1 paso
Sleep(200); // delay o retardo
ShowMessage("Transferencia realizada"); // muestra un mensaje
Application->Terminate(); // termina el programa

Probar la aplicacién: Pulsa Run > para comprobar su funcionamiento.

Barra de Progreso con for:
Ahora afnade un segundo botén con esye cddigo y comenta la diferencia:

void _ fastcall TForml::Button2Click(TObject *Sender)
{
for (int i=1 ;100;i++) //repite 100 veces
{
ProgressBarl->Position ++; // incrementa 1 paso
Sleep(200); // delay o retardo
}
ShowMessage("Transferencia realizada"); // -> muestra un mensaje
Application->Terminate(); //-> termina el programa
)j

= Guardar el proyecto: Crea una carpeta que se llame: Transferencia?
o Escoge: File » Save as... Para guardar el archivo: Transferencia2.cpp
o Escoge: File » Save project as... Para guarda el proyecto Transferencia2.cbproj y Trasferencia2h.hpp
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Construccion de una aplicacion con dos formularios. Mensajes
Teoria previa: if/else permite separar las acciones en dos casos; el caso verdadero o falso seglin se cumpla o no la

comparacion. Sintaxis:
» Crear aplicacién nueva:
» (File - New — VCL Form Applicaton C++ Builder)
Formulario principal: Poner los siguientes componentes:

3 Label (solapa Standard), 3 Edits (solapa Standard), y 2
botones BitBtn (solapa Additional).

Distribuir los objetos para que la ventana tenga el aspecto
de la imagen.

En una carpeta nueva llamada: Mensajes, guarda esta
unidad (File » Save as...) con el nombre mensajel.cpp, el
archivo cabecera por defecto y el proyecto con el nombre:

mensajes.cbproj

v

-

Configurar el formulario secundario.

» Afiade un nuevo formulario al proyecto: selecciona File » New Form

» Cambia las propiedades del formulario:
Name =SaludoBox y Caption= Cuadro de saludo.

» Afiade un componente Label lamado Labell. Como en la imagen.
» Guarda esta unidad (File » Sav e as...) con el nombre saludol.cpp y el

archivo cabecera: saludo.h

Escribir el codigo.

if (comparacioén) {accién_verdadera} else {accidén_falsa}

(¢} Form1 | BitBtn1 TEitBin | = || &2

Lottty Kind bkOK L
Apelidos |EditApelidos o

| Clave  Sessssssse 3| X cancel

AP }?/.. o @ i\&i:: L
EditClave TEdit B BItB‘FnE 'I::;itln
PasswordChar = CE.IptIOH r

Kind bkClose

En este caso, sélo se escribird cddigo para el evento OnClick del componente BotonOK del formulario principal.
Con dicho componente seleccionado, ir a la pestafia Events del inspector de objetos y hacer doble click en el evento

OnClick. El gestor de este evento quedard como sigue:

void _ fastcall TForml::BitBtnlClick(TObject *Sender)
{

SaludoBox ->Labell->Caption = "Bienvenido, " +
SaludoBox ->Show();

}

(*) Entorno multidevice la propiedad es: Label1->Text %‘

EditNombre->Text ; //pone texto en Labell (*)

En el formulario principal, seleccionar File - Use Unit y seleccionar Saludo1.

Observar que se afiade la linea: #include "Saludo.h" vy ejecuta
Variante 1:

Cambia el cddigo del evento OnClick por el siguiente:

el programa.

void _ fastcall TForml::BitBtnl1Click(TObject *Sender)
{
if (EditNombre->Text == "" || EditApellidos->Text ==
{ ShowMessage ("Debe especificar todos los campos"
}
else {
SaludoBox->Labell->Caption = "Bienvenido,
EditApellidos->Text + ". Su clave es:
SaludoBox->ShowModal();
} o}

+ EditNombre->Text +
" + EditClave->Text;

| | equivale a un O légico, && equivale a un 'Y logico

")

"" || EditClave->Text ==
); //mostrar mensaje

El siguiente codigo muestra un mensaje si la clave es incorrecta y prepara entrada para nuevo usuario:

void _ fastcall TForml::BitBtnl1Click(TObject *Sender)

SaludoBox->Labell->Caption = "Bienvenido,
EditApellidos->Text + ". Su clave es:
SaludoBox->ShowModal();

//prepara un nuevo usuario:
EditNombre->Text = "";
EditApellidos->Text = "";
EditClave->Text = "";

EditNombre->SetFocus();

1}

{
if (EditNombre->Text == "" || EditApellidos->Text ==
{ ShowMessage ("Debe especificar todos los campos");
else if (EditClave->Text != "ofimega") {ShowMessage(
else {

"" || EditClave->Text == "" )
//mostrar mensaje

"Clave incorrecta");

+ EditNombre->Text + +

" + EditClave->Text;

En el siguiente cédigo, cambia el error de clave (ShowMessage("Clave incorrecta” ) por una ventana de dialogo:
MessageDlg("Clave incorrecta",mtError,mbAbortRetryIgnore,0); o MessageDialogSync en plataforma FMX
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Ejercicio 4: Conversor

Teoria previa:
» StrTolnt y InttoStr: Son funciones que convierten un valor de numérico entero (integer) a texto y viceversa

» FloatToStr y StrToFloat: Convierten un valor de numérico decimal flotante (float) a texto y viceversa
» Sender: Es un parametro que indica el nombre del objeto que ha desencadenado el evento

Ejercicio:

= Crear una nueva aplicacién

o Version VCL (libreria visual c para windows) escoge del menu: File - New — VCL Form Applicaton C++ Builder.

o Version Multidevice: File - New - Multi-device application C++ Builder ... ... ... ... ... ........

= En el formulario nuevo, desde la Tool palette, afiade: 2 edits, 1 botony 3 4 REREEEE a AEIFont »|size 14 »LSiZE )
labels -2 Lonversos de eurog © it

= Cambia la propiedad caption (o Text) de las label y del botén para que |- o0 iiiiiiiiiiin il
muestre el texto de la imagen derecha. — Edit1 | Button1 |- [Editz

= Pulsa doble clic encima del botdn para llamar al evento (on click)
void __fastcall TForm1::Button1Click(TObject *Sender) y escribe:
Edit2->Text=Editl->Text * 1.3;
Si no funciona correctamente escribe en su lugar:
Edit2->Text=StrToInt(Editl->Text) * 1.3;
= Pulsa en Run [> para comprobar su funcionamiento.
Si funciona correctamente, guarda toda la aplicacion: Fila — Save all
El archivo de unidad se llamard: Conversorl.cpp, el proyecto Conversor.cbproj y su archivo cabezera ConversorCH1.h

Usar dos botones con la misma funcién (usando el pardmetro sender)
Afade un segundo botdn Button2 como en la imagen. —
En el cédigo del botdn Buttonl cambia el codigo por el del recuadro.

void __ fastcall TForml::ButtonlClick(TObject *Sender)
{
if (Sender = Button2) { Button2 TEutton
, Edit2->Text=Editl->Text*1.3; Pmpmieslm‘
else #| LiveBindings LiveBindings
{ | OnClick ButtoniClick |~
Editl->Text=Edit2->Text/1.3;
}
}

= En el evento onclick del botdn 2 tienes que asignar el mismo evento que el del botén 1 para que ambos botones llamen
a la misma funcion.
= Sj funciona correctamente, guarda toda la aplicacion: Fila — Save all.

Version Multidevice para android (Firemonkey. Para versiones XE3 y superiores)

» Escoje: File - New - Multi-device application C++ Builder (Versiones XE3 ~ XE4: File — New — Firemonkey)
= Diseflo: Header footer -

- Guardar en la carpeta: conversor, _nin]

=  Afadir 2 labels, 2 Spinbox y 2 botones. Conversor
= Cambiar las propiedades como en la figura: =
=  Afadir el codigo a cada botdn: % @ §
. ® Pasar a cm -> ®
ButtonCmClick: 3 ~ L
SpinBox2->Value=SpinBox1->Value*2.54; Name [ButtonCim
ButtonPulgaClick: Pulgadas Centimetros
SpinBox1->Value=SpinBox2->Value/2.54; RN < 0 >
= Sj funciona correctamente, guarda toda la aplicacidn: Fila — Save all.
Guarda la unidad cpp, el archivo cabecera h y el proyecto: cbproj con el <- Pasar a pulgadas
nombre: ConversorM.cbproj
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Ejercicio 4 ext: - Area del tridngulo Form1 ==E=R

= Afiadir al ejercicio anterior los componentes de la imagen. """"""""""""""
= Cambiar el evento: OnClick del botdn Buttonl por: s R e

R = Edit1
void __fastcall TForm1::Button1Click(TObject *Sender) Ll e —
{ Lo Altra: e Edit2 .
Edit3->Text=FormatFloat ("###.##",Edit1l->Text.ToDouble() * 200caaaon[————— coooooaaaa
Edit2->Text.ToDouble()/ 2 ); s Calodlar C

} © . Arear - - —= Edit3

Version Multidevice o Firemonkey (XE): o e

= Nota: En la etiquetas Labels, cambia

la propiedad Caption por la #Z Object Inspector T1E] -
propiedad Text. Form1 TForm1
= Afiadir al Form1 un componente: Properties | Events
StyleBook1 Quality cosystemDefault StyleBook1
i ShowFullScreenlIcon || False Altura
= Pulsar doble clic sobre el » |styleBook -

Calcul
componente StyleBook1 y cargar StyleLookup alcular
(Load...) de la carpeta: StyleName

Tag a
Users\Public\Documents\RAD Top 0
Studio\12.0\Styles el estilo: #|Touch {TTouchManaa

AquaGraphite.style — Apply and close
= Cambiar la propiedad del formulario Form1. Stylebook:

= Guardar ( File - Save Project ) Guarda la unidad cpp, el archivo cabecera h y el proyecto: cbproj

Uso de variables de fecha y decimal:
Una variable almacena un valor temporalmente para utilizarlo después. Hay que declararlas antes de usarlas.
Variables primitivas: pueden ser numéricas (integer), decimales (single o double), légicas (bool)
Variables Complejas o de un tipo de clase: Son de fecha (Tdatetime), de texto(String) o de objetos.

= Crea una nueva aplicacién VCL (libreria visual) () Formb \E]‘E"Fﬁjm TDateTimePicker
escogiendo del menu: File - New — VCL Form Applicaton.
= Afiade un botdn Button1, dos etiquetas, labels y dos | Fecha de inidig: . | 120/03/2014 o]
DatetimePicker de la paleta Win32. fececcbcaiiocesieacoocosesa sty
= Cambia el nombre de los DatetimePicker por: - Fecha finalizacdn - 150/03/2014  [@g |
Fecha_ini 'y Fecha_fin LIl g a9l |Fecha_fin TDateTimePicker
= Pulsa doble clic sobre el botén y escribe en el evento del ;:Calculgr dias @01l
botdn OnClick: [ iliiiiiiiiiiiiiiin
void _ fastcall TForml::ButtonlClick(TObject *Sender) =~ - - - -0 0 - - 0 0
t double dias; //-> creo una variable decimal doble

TDateTime hoy; //-> creo una variable del tipo fecha/hora (empieza con mayusculas)
dias=Fecha_fin->Date-Fecha_ini->Date; // -> resto las dos fechas

hoy=Date(); //Date() recoge la fecha del sistema

ShowMessage("Hoy es "+ DateToStr(hoy)+ " y han transcurrido "+FloatToStr(dias)+" dias");

}

® Pulsa Run [> para comprobar su funcionamiento. = |

. . . Escoge tu fecha de nadmiento - - - -

Variante del ejercicio. Calcula tu edad:

4 marzo de 2014 L
= Cambia el formulario como en la imagen - Cl o ma mic juo wie sd do. |
* Escribe en el evento del botén OnClick: '-31 VR “ ; ;
void __fastcall TForml::ButtonlClick(TObject *Sender) [ .

1011 12 13 14 15 16
{ , ) ) <117 18 1w [20] 21 2 23
double dias,anyos; //-> declaro dos variables decimales | 24 35 25 27 23 20 3
TDateTime hoy = Date(); //-> declaro y asigno un valor a la vez 131 1 2 2 4 5 6
dias:hoy—MonthCalendar‘l—>Date; //-> calculo los diNas transcurri.dos [ [ Hoy: 20/03/2014 :
anyos=dias/365; //-> calculo los afnos transcurridos e T e — I
ShowMessage("Tienes "+FormatFloat("##0.##",dias)+" dias o joooosc acoocoooa
"+FormatFloat("##0.##",anyos)+ " afios"); oocni Calodaredad Lo
}

Ejecuta y guarda: Pulsa Run [> para comprobar su funcionamiento.
Para guardar primero la unidad y luego el proyecto, escoge del menu: File » Save project as...
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Uso del switch — case — Sender. Ejercicio direcciones

Preparacion:
» Crea una Carpeta nueva llamada Direcciones donde vamos a guardar nuestro proyecto.
» Utiliza una aplicacién como Paint para Guardar en la carpeta Direcciones . l . .

las cuatro imagenes siguientes en formato bmp de 16 bits.
Flecha_ab.bmp Flecha_ar.bmp Flecha_der.bmp Flecha_izbmp

En Visual C++ Builder, crea un nuevo proyecto (menu: File - New — VCL Form Applicaton C++ Builder)

Afiade al formulario 4 Speedbuttons R

asigna a cada uno, en su propiedad Glyph Ia§ cuatro imagenes anteriores SpeedButton! TSpecdBution |

asigna a cada una en la propiedad Tag los nimeros del 1 a 4 Tag 1 '

Con la propiedad Tag podemos marcar un objeto con un valor

v

v

- ‘* Name Shapel
| Pen (TPen)
? & Shape stCircle

v

Afade al formulario un componente Shape y asigna su propiedad Shape: el tipo stCircle

Object Inspector 1%
SpeedButtom TSpeedButtor -
Properties | Events .
En el primer SpeedButton, pulsa doble clic sobre el evento: OnClick - » | Action v
#|LiveBindings LiveBindings
OnClick SpeedButton1Click
. L OnDbIClick E j
= Escribe en el evento el cédigo:
void __ fastcall TForml::SpeedButtonlClick(TObject *Sender)
{
TSpeedButton *Boton=(TSpeedButton*) Sender; //variable objeto boton recogido del Sender
switch (Boton ->Tag) //evaluamos el Tag del boton
{
case 1: Shapel->Top++; //si el Tag es 1 desplaza arriba
break;
case 2: Shapel->Left++; //si el Tag es 2 desplaza a la derecha
break;
case 3: Shapel->Top--; //si el Tag es 3 desplaza la izquierda
break;
case 4: Shapel->Left--; //si el Tag es 4 desplaza a abajo
}
}

Esta funcidn distinguira desde qué boton ha sido llamada evaluando la propiedad numérica Tag.

Para evaluar la propiedad Tag del objeto recibido por el Sender se lo asignamos a una variable del tipo objeto
Tspeedbuton que la llamaremos Boton.

Otra opcion para evaluar una propiedad del Sender es:  dynamic_cast < TSpeedButton *>(Sender)->Tag

= Asigna a los otros botones el mismo evento del primer boton: Object Inspector %
. . . .y SpeedButton1 TSpeedButto -
Esto hard que todos los demds botones desencadenen a la misma funcién que el ‘ ": : °"E -
. L, ropertes | events
primer boton. . =
#|LiveBindings LiveBindings
OnClick SpeedButton1Click
OnDblClick E J

Prueba esta otra alternativa en el cddigo con la opciodn if — else if, que puede parecer mas corta pero tenemos que saber e
nombre del boton...

void _ fastcall TForm9::SpeedButtonlClick(TObject *Sender)
{
if (Sender = SpeedButtonl) { Shapel->Top++;}
else if (Sender = SpeedButton2) { Shapel->Top--;}
else if (Sender = SpeedButton3) { Shapel->Left++;}
else if (Sender = SpeedButton4) { Shapel->Left--;}
¥

Ejecuta y guarda: Pulsa Run [> para comprobar su funcionamiento.
Para guardar el proyecto y la unidad, escoge del menu: File » Save project as...
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Pizarra de dibujo (VCL)

= Crear una nueva aplicacion VCL (libreria visual) escogiendo del menu: File - New — VCL Form Applicaton C++ Builder.

= Cambiar el nombre y titulo del formulario principal: Con el inspector de objetos, cambiar la propiedad Caption por
PIZARRA y |a propiedad Name por MainForm.

= Guardar (File » Save As) la unidad asociada al formulario (Unitl.cpp, por defecto) como PizarraUnit.cpp. El archivo
cabezera a Pizarrah.h y el proyecto (File | Save Project As) como Pizarra.bpr. o .cbproj

= Poner icono: Para asignar un icono: (Project - Options » Application). Puls: Load Icon... - Seleccionar un icono.

= Temas en XE: Asignar un tema: Esoge (Project - Options - Application) - Appearance. Escoge: Amakrits. Asigna el
tema como Default y pulsa Ok

=  Comprobamos: Project —Run. ) MainForm =N =h
r T T T —~ = =
Disefo del formulario principal: | PaintBox L |
= Fijar manualmente el tamafio del Form a 300 X 400: | r:‘;m: Pari:th'x |
(Height = 300 y Width = 400) Nombre: MainForm | o aloe |
Afadir 3 componentes: L |
=  En la parte superior, alineado a lo alto (Align: alTop), un | 9
componente PaintBox (solapa System). Fijar las propiedades:
Name = PaintBox, Align = alTop y Height = 225. | |
=  Debajo del PaintBox un componente Bevel (solapa Additional). | T T |
Fijar las siguientes propiedades: Name = Linea, Align = alTop, | Caption &Salir |
Style = bsLowered y Height = 8. == = — — — ¢
= Debajo del Bevel, centrado horizontalmente un componente | A BF“E'ln'5E'-'E Eit /
BitBtn (solapa Additional). Fijar las siguientes propiedades: L mgna P L

Name = ExitBtn, Kind = bkClose y Caption = &Salir.
Escribir el cédigo.

En primer lugar, escribiremos el cdédigo asociado al evento OnPaint del componente PaintBox. Seleccionar en el

inspector de objetos dicho componente, y tras seleccionar la pestafia Events haremos doble click en el gestor del

evento OnPaint. El gestor de este evento quedard como sigue:

void __fastcall TMainForm::PaintBoxPaint(TObject *Sender)

{ Left Width
// Dibujar un circulo amarillo: -— pi
PaintBox->Canvas->Pen->Color = clBlack; 0, 0)
PaintBox->Canvas->Brush->Color = clYellow;
PaintBox->Canvas->Ellipse (100, 100, 150, 150);
// Dibujar un cuadrado rojo:
PaintBox->Canvas->Pen->Color = clRed; Y B
PaintBox->Canvas->Brush->Color = clRed; HEightI Windows Controls
PaintBox->Canvas->Rectangle (200, 100, 250, 150); .2
/*Si quisiera dibujar una linea en diagonal:
PaintBox->Canvas->MoveTo(0,PaintBox->Height/2);
PaintBox->Canvas->LineTo(PaintBox->Width,PaintBox->Height/2);*/

¥

Top

Finalmente, escribiremos el cédigo asociado al evento OnC11ick del componente BitBtn (ExitBtn):
void __fastcall TMainForm::ExitBtnClick(TObject *Sender) //-----=========---
{

Application->Terminate();
//o también: MainForm->Close();

Eventos del Mouse: Dibujar en la Pizarra:

Crearemos una variable publica Pintar del tipo “Flag” booleriana que nos dé permiso para pintar al presionar el botén del
mouse pero no lo permita si movemos el mouse sin apretar el botdn.

e Recupera el proyecto anterior (File » Open): Pizarra. .cbproj

Anula el codigo de la Funcidn PaintBoxPaint. Para ello utiliza los caracteres /* y */ para convertirlo en comentario.
Afade la variable booleriana tras las lineas de Include de cabazera iniciada por defecto en false: bool Pintar = false;
Afade las siguientes funciones para los eventos on mousedown, on mouse up y on mousemove del objeto Paintbox:

void __fastcall TMainForm: :PaintBoxMouseDown(TObject *Sender, TMouseButton Button, TShiftState Shift, int X, int Y)
{

Pintar = True;
PaintBox->Canvas->MoveTo(X,Y);

}
void __fastcall TMainForm::PaintBoxMouseUp(TObject *Sender, TMouseButton Button, TShiftState Shift, int X, int Y)
{

Pintar = False;

}
void __fastcall TMainForm::PaintBoxMouseMove(TObject *Sender, TShiftState Shift, int X, int Y)
{

if (Pintar==True) {PaintBox->Canvas->LineTo(X,Y);

}
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Ejecuta y prueba (Run): Al arrastrar el mouse sobre el objeto Paintbox dibujard desde la coordenada que se indica en
PaintBoxMouseDown.

Guardar: Guarda todo (File » Save All) ) MainForm ===

Cuadro de didlogo color. |
Afade un nuevo botdén BitButton junto al de Salir Ilamado: Colory un |
Componente ColorDialog de |a paleta Dialogs. |
Desencadena el evento Onclick donde afiadiras el cédigo: |
|
|
|
|

void __ fastcall TMainForm::ColorClick(TObject *Sender) {Ei}’(//{,/

||

|
|
|
MName ColorDialogl :
|
|
|

if (ColorDialogl-s>Execute()) { ColorDialog1
PaintBox->Canvas->Pen->Color = ColorDialogl->Color; .
} 3 i
S e e
Comprueba su funcionamineto (Run) y Guarda todo (Save All) Salir -

Probar y guardar: Pulsar Run » para probra y Guarda todo (File » Save All)
Esto guardard: PizarraUnit.cpp - Pizarrah.h - Pizarra. .cbproj

Archivo INI de configuracion: (ampliacion)
#tinclude <IniFiles.hpp>
String dire;
dire=ExtractFilePath(ParamStr(0));
void __fastcall TForml::FormCreate(TObject *Sender)

{
TIniFile *INI = new TIniFile("Config.ini");
Left = INI->ReadInteger("FormPos", "Left", 250);
Top = INI->ReadInteger("FormPos", "Top", 200);
delete INI;
}
/== e e e e e e e e e e e e e e e oo oo
void __ fastcall TForml::FormClose(TObject *Sender, TCloseAction &Action)
{
TIniFile *INI = new TIniFile("dire+Config.ini");
INI->WriteInteger("FormPos", "Left", Left);
INI->WriteInteger("FormPos", "Top", Top);
delete INI;
}

Ejercicio - Uso de rejilla StringGrid con Firemonkey

= (Crear una nueva aplicacién:
o Versiones posteriores a XE7: File - New - Multi-device application C++ Builder
o Versiones XE anteriores: File — New - Firemonkey — Mobile Application C++ Builder
= Disefio: Header footer - Guardar en la carpeta Elementos
= |Inserta una etiqueta Label y una rejilla Grid o mejor StringGrid (porque va a contener sélo texto) en el formulario.
= Con el botdn derecho sobre la Stringrid escoger: Items editor y afiadir 2 columnas. Pon su propiedad Align al Bottom.
= Cambia la propiedad Header de la column1 y column2 por: elemento y n2 atdomico.
= Paraintroducir los datos en tiempo de ejecucidn, activar el evento On Show (al mostrar la ventana).

Escribe el cddigo para el evento: onshow FormShow:

void _ fastcall THeaderFooterForm::FormShow(TObject *Sender) Buscador de elementos

{
StringGridl->Cells[@][@]="Hidrégeno"; Esoja de la lista....
StringGridl->Cells[1][0]="1"; 5 ®
StringGridl->Cells[@][1]="Helio"; Elemento N° Atémico
StringGridl->Cells[1][1]="2";

}

= Al hacer clic en un elemento de la lista debe aparecer su valor en la etiqueta Labell

Escribe el cddigo para el evento OnSelectCell de la StringGridi:
void __ fastcall THeaderFooterForm::StringGridlSelectCell(TObject *Sender, const int ACol,
const int ARow, bool &CanSelect)

{

int fila;

fila=ARow;

Label1->Text=StringGridl->Cells[0][fila] + " = "+ StringGridl->Cells[1][fila];
¥

® Comprueba runeando la aplicacion [F9] y si funciona correctamente, guarda toda la aplicacién: Fila — Save all.
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Ejercicio: Crear un contador de tiempo. Practicar con tipos de variables.

Variables publicas: Crearemos dos variables para almacenar dos datos:

la hora de inicio y la hora final. Si estas variables van a ser utilizadas en

todo el programa, se crea al principio, para que sean reconocidas por

toda la unidad. N

Ejercicio:

» Crear una nueva aplicacién llamada CRONO. Afade al formulario P | Panelt
(ventana) los siguientes componentes: T e Labelt

: L= | ghel?
- 1 SpeedButton Texto o caption: Empezar : Hora final: /_JE Label3
Propideades en VCL: Down v AlowUp ¥' y Grouplndex=1 : /
Propiedades en FMX: StaysPressed v IsPressed v/ : Tiempo:

-1 panel [ con 3 Labels =] con Autosize v/
Al inicio: double horalInicio,horaFin;

Button

Version para VCL: Variantes en multidevice FMX:
void _ fastcall TForml::SpeedButtonlClick( . . .) void _ fastcall Forml::SpeedButtonlClick(. . .)
{ double crono=0;
double crono=0; if (SpeedButtonl->IsPressed ==true) {
if (SpeedButtonl->Down ==true) { Labell->Text = "Hora de inicio: " +
Labell->Caption = "Hora de inicio: " + TimeToStr(Time());
TimeToStr(Time()); SpeedButtonl->Text="Parar";
SpeedButtonl->Caption="Parar"; horalnicio=Time();
horalnicio=Time(); }
} else {
else { Label2->Text = "Hora final: " +
Label2->Caption = "Hora final: " + TimeToStr(Time()); TimeToStr(Time());
SpeedButtonl->Caption="Empezar"; SpeedButtonl->Text="Empezar";
horaFin=Time(); horaFin=Time();
crono=(horaFin-horalInicio)*100000; crono=(horaFin-horalnicio)*100000;
Label3->Caption="Crono: " + Label3->Text="Crono: " +
FloatToStr(RoundTo(crono,-3)); FloatToStr(RoundTo(crono,-3));
} }
} }

Ejercicio. Creacion de objetos en tiempo de ejecucién. (Entorno firemonkey multidevice)
» Crear una nueva aplicacion: File - New - Multi-device application C++ Builder
Para versiones anteriores de XE: File — New - Firemonkey — Mobile Application C++ Builder
»  Establece la propiedad del formulario WindowState: wsMaximized (maximizado)
»  Afade un Label y dos botones (TButton) como en la imagen al formulario
» En el botén2 de Jugar, Busca el Evento: On mouse enter y pulsa doble clic para tener

el cédigo: Button2MouseEnter
void _ fastcall TForm5::Button2MouseEnter(TObject *Sender)

{
int aleatorioX=Random(Form5->Width-Buttonl->Width);
int aleatorioY=Random(Form5->Height-Buttonl->Height);
Button2->Position->X=aleatorioX;
Button2->Position->Y=aleatorioY;

¥

»  Pulsa doble clic sobre el botén Salir para escribir el codigo:
void _ fastcall TForm5::ButtonlClick(TObject *Sender)
{
int i,j,k; //creo tres variables numéricas
TButton *miboton; //creo una variable del tipo botdn en C# equivale a TButton miboton = New TButton

for (i =0; 1< 10; i++) {
miboton = new TButton(NULL);
miboton->Parent=Form5;
miboton->Width=100;
miboton->Height=50;
miboton->Text="Salir";
j=Random(Form5->Width);
k=Random(Form5->Height);
miboton->Position->X=j;
miboton->Position->Y=k;
miboton->0OnClick=ButtonlClick;

Yol
® Prueba la aplicacién (P Run) Si funciona correctamente, guarda toda la aplicacién: Fila — Save all.

El archivo unidad se llamara: Juegol.cpp, el proyecto Juego.cbproj y su archivo cabezera JuegoCH1.h
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Reproductor multimedia en FMX

e Hacer una nueva Multidevice application — C++ Builder
e Renombrar el formulario a MusicForm
e Afadir las imagenes de los botones del reproductor en el

Q0 O©O00O00O0

: bPlay  bst bP bAbri
No selected media file._ VB LIRS b

Labelinfo

componente Imagelistl y asociar en los botones de la
toolbar:

Images = Imagelistl - Imagelndex =1

En MediaPlayerControll: Mediaplayer = MediaPlayerl

MediaPlayerControll

i
S
Nombrar los componentes como se muestran en la Bt
. Tirmerl  MediaPlayerl OpenDialog1 Imagelist1
imagen.
Abajo tienes el codigo base.
Para finalizar, guarda el proyecto como MusicPlayer.cproj LabelTempo
o TrackTempo 0:00

void _ fastcall TMusicForm::bAbrirClick(TObject *Sender)

if (OpenDialogl->Execute()) {
MediaPlayerl->FileName = OpenDialogl->FileName;
LabelInfo->Text=0OpenDialogl->FileName;
TrackTempo->Max=MediaPlayerl->Duration;
LabelTempo->Text="0:00/"+FloatToStr(MediaPlayerl->Duration);

void __ fastcall TMusicForm::TrackTempoTracking(TObject *Sender)
{

MediaPlayerl->CurrentTime=TrackTempo->Value;

1. void _ fastcall TMusicForm::bPlayClick(TObject *Sender)

String titulo=ExtractFileName(MediaPlayerl->FileName);
if (titulo!="") {

if (Sender==bPlay) {
MediaPlayeril->Play();
LabelInfo->Text=titulo+" - Playing";
Timerl->Enabled=true;

}

else if (Sender==bStop) {
MediaPlayerl->Stop();
LabelInfo->Text=titulo+" - Stoping";

}

else if (Sender==bPause) {

if (MediaPlayeril->State==1) //si State estd en play..

{
MediaPlayeri1->Stop();
LabelInfo->Text=titulo+"- Pause";
}
else { //si State estd en Stop..
MediaPlayeri->Play();
LabelInfo->Text=titulo+"- Playing";
}
}
}
}
F R e i LR R

void _ fastcall TMusicForm::TimerlTimer(TObject *Sender)
{
double dura=MediaPlayerl->Duration;
double tempo=MediaPlayerl->CurrentTime;
TrackTempo->Value = MediaPlayerl->CurrentTime;
TDateTime ttempo = tempo/1000000000000;
TDateTime tdura = dura/1000000000000;
LabelTempo->Text = TimeToStr(ttempo)+" / "+ TimeToStr(tdura);
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VCL: Eventos del teclado: direccion de nave.

= Dibujar previamente, desde Paint, 4 imagenes de una nave
conteniendo las cuatro direcciones. Guardar en la carpeta
Naves.

=  Desde C++ Builder, crear una nueva aplicacion escogiendo del
menu: File - New — VCL Form Applicaton C++ Builder.

= Cambiar la propiedad Caption del formulario por Naves, su
propiedad KeyPreview por True y su propiedad
DoubleBuffered por true.

= Guardar (File » Save As) la unidad asociada al formulario (Unitl.cpp, por defecto) como NaveUnitl.cpp. El archivo
cabezera a Nave.h y el proyecto (File | Save Project As) como Naves.bpr. o .cbproj en la carpeta Naves.

= Adadir 5 componentes de imagen con los nombres de la figura. Cargar, desde su propiedad Picture, las imagenes

Buttonl

Button2 Panel1

previamente dibujadas.
void __ fastcall TForml:

{
//ShowMessage(Key); para test de tecla

switch (Key)

case 37: Nave->Left=Nave->Left-1;

:FormKeyDown (TObject *Sender, WORD &Key, TShiftState Shift)

break;
case 38: Nave->Top=Nave->Top-1;
break;
case 39: Nave->Left=Nave->Left+1;
break;
case 40: Nave->Top=Nave->Top+1;
}
}
Variante Imagelist:
Selected Image
=  Borrar los 4 componentes de imagen y agregar un componente Imagelist. Enfjnfcu'””
=  En el componente Imagelist, agregar las 4 imagenes de posicién de la nave Fil Color:
= Cambiar el cddigo anterior por: Dopm
SWitCh (Key) @) Crop Stretch
{ Images
case 37: izquierda(); A v =3 <]
break; 0 ! : ?
case 38: ar‘r‘iba(); Add... Replace... Delete
break;
case 39: derecha();
break;
case 40: abajo();
}

= Crear las funciones:

void __ fastcall TForml::izquierda()
{ImageListl->GetBitmap(2,Nave->Picture->Bitmap);
Nave->Left=Nave->Left-1;}
__fastcall TForml::arriba()
{ImageList1->GetBitmap(0@,Nave->Picture->Bitmap);
Nave->Top=Nave->Top-1; }
__fastcall TForml::derecha()
{ImageList1->GetBitmap(3,Nave->Picture->Bitmap);
Nave->Left=Nave->Left+1;}
__fastcall TForml::abajo()
{ImageList1->GetBitmap(1l,Nave->Picture->Bitmap);
Nave->Top=Nave->Top+1;}
= Declarar las funciones en el archivo cabecera h:

void

void

void

void _ fastcall izquierda();
void _ fastcall arriba();
void _ fastcall derecha();
void _ fastcall abajo();
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Ampliaciéon: Uso de un procedimiento: llamar a una funcién con parametros.

Afnadir ‘E Shape de forma circle , llamarle:bala , visible:false

Afadir Timer (de paleta system): Timerl — Interval: 10

Declara la funcion en el archivo cabecera h:

En el archivo cpp:
Afadir las variables publicas:
int direccion;
int velocidad;
Cambiar el cédigo:
void _ fastcall TForml::FormCreate(TObject *Sender)

void _ fastcall mover(int direc);

{

ImagelListl->GetBitmap(2,Nave->Picture->Bitmap);

velocidad=2;

}

void _ fastcall TForml::FormKeyDown(TObject *Sender, WORD &Key, TShiftState Shift)

{

}

switch (Key)

case 37:

break;

case 38:

break;

case 39:

break;

case 40:

break;

case 32:

mover(3);
mover(9);
mover(2);
mover(1);

dispara();

void __fastcall TForml::mover(int direc)

void __ fastcall TForml

{ImageListl->GetBitmap(direc,Nave->Picture->Bitmap);
direccion=direc;
switch (direccion)

case 3: Nave->Left=Nave->Left-velocidad;//izquierda();

{
break;
case 0: Nave-
break;
case 2: Nave-
break;
case 1: Nave-
}

}

>Top=Nave->Top-velocidad;//arriba();
>Left=Nave->Left+velocidad;//derecha();

>Top=Nave->Top+velocidad;//abajo();

: :dispara()

{

bala->Left=Nave->Left;
bala->Top=Nave->Top;
bala->Visible=true;
Timerl->Enabled=True;

}
void _ fastcall TForml::TimerlTimer(TObject *Sender)

switch (direccion)

{

case 3: bala->Left=bala->Left-velocidad; //izquierda();

break;

case 0: bala->Top=bala->Top-velocidad; //arriba();

break;

case 2: bala->Left=bala->Left+velocidad; //derecha();

break;

case 1: bala->Top=bala->Top+velocidad; //abajo();

}
if ((bala->Left> Forml->Width) && (bala->Left<® ) & & (bala->Top<@ ) &&
{Timerl->Enabled=false;
bala->Visible=false; }

}

Trucos:
Para quitar el marco de la ventana: Selecciona el formulario y cambia las propiedades:
BorderStyle: bsnone vy
Para salir con tecla escape: Afiadir el caso al procedimiento FormKeyDown :
case 27: Forml->Close();

WindowState: wsMaximized

//tecla escape = 27

(bala->Top>Forml->Height ) )
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FMX: Movimiento en pantalla (Uso del estamento CASE)

Ingredientes:

- Shape‘h (de la Paleta Additional o Shapes): Name: Bola; Shape: Circle

- Timer (de paleta system): Timerl — Interval: 30
- Botones: 2 (Empezar y parar)

- Formulario: Si lo deseas, puedes asignar color transparente o negro (Fill: black kind: solid)

Variables: afiadir al principio como variable publica:
Int mover=1;

Acciones:
void

{mover=1;
Timerl->Enabled=True; }

void __ fastcall TForm1::BpararClick(TObject *Sender)
{Timerl->Enabled=False; }

Meétodo utilizando las funciones swith - case

//* al parar el botén

fastcall TForm1::BempezarClick(TObject *Sender) //* al pulsar el botén empezar

switch - Case:
Bifurca las acciones dependiendo de
un parametro del tipo ordinal

void _ fastcall TForml::TimerlTimer(TObject *Sender) //***** al activar el timer

switch (mover)

case 1: //
bola->Position->X++;
bola->Position->Y++;
if (bola->Position->X>=Forml->Width-bola->Width)
{mover=2;};
if (bola->Position->Y>=Forml->Height-bola->Height)
{mover=3;};

break;

case 2: //
bola->Position->X--;
bola->Position->Y++;
if (bola->Position->X<=0) {mover=1;};
if (bola->Position->Y>=Forml-y Height-bola->Height)
{mover=4;};

abajoder

abajoiz

Meétodo utilizando if funciones creadas

void __ fastcall TForml::TimerlTimer(TObject *Sender)
{

if (mover==1) {abajoder();}
else if (mover==2) {abajoiz();}
else if (mover==3) {arribader();}

else if (mover==4) {arribaiz();}

//********************************************

void __ fastcall TForml::abajoder()

bola->Position->X++;
bola->Position->Y++;
if (bola->Position->X>=Forml->Width-bola->Width)
{mover=2;};
if (bola->Position->Y>=Forml->Height-bola->Height)
{mover=3;};
}
void _ fastcall TForml::abajoiz()

{

bola->Position->X--;

Recuerda declarar en el archivo cabecera (.h) las funciones:
void _ fastcall abajoiz();
void _ fastcall arribader();

void _ fastcall abajoder();
void _ fastcall arribaiz();

break;

case 3: // arribader
bola->Position->X++;
bola->Position->Y--;
if (bola->Position->X>=Forml->Width-bola->Width)
{mover=4;};
if (bola->Position->Y<=0) {mover=1;};

break;

case 4: // arribaiz
bola->Position->X--;
bola->Position->Y--;
if (bola->Position->X<=0) {mover=3;};
if (bola->Position->Y<=0) {mover=2;};

}

bola->Position->Y++;

if (bola->Position->X<=0) {mover=1;};

if (bola->Position->Y>=Forml->Height-bola-
>Height) {mover=4;};

void _ fastcall TForml::arribader()

bola->Position->X++;
bola->Position->Y--;
if (bola->Position->X>=Forml->Width-bola->Width)
{mover=1;};
if (bola->Position->Y<=0) {mover=3;};
¥

void _ fastcall TForml::arribaiz()

bola->Position->X--;
bola->Position->Y--;
if (bola->Position->X<=0) {mover=3;};
if (bola->Position->Y<=0) {mover=2;};

}
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FMX direccion de nave Multidevice

»  Cédigo Nave para Multidevice

void __fastcall TFormNave: :FormKeyDown
switch(Key)
{
case 27:{
ShowMessage("Desea salir del juego?");
}
break;
case 37:{ //flecha izda
izquierda();
}
break;
case 38: { //flecha arriba
arriba();
}
break;
case 39: { //flecha derecha
derecha(); void
} {
break;
case 40: { //flecha abajo
abajo();
}
break;
}
}

void __fastcall TFormNave::izquierda()

__fastcall TFormNave::TimerlTimer (..)

Nave->Position->X=Nave->Position->X+VelH;
Nave->Position->Y=Nave->Position->Y+VelV;
if (Nave->Position->X>=FormNave->Width) {
Nave->Position->X=0;

}

if (Nave->Position->Y>=FormNave->Height) {
Nave->Position->Y=0;

}

if (Nave->Position->X<0) {
Nave->Position->X=FormNave->Width;

}

if (Nave->Position->Y<0) {
Nave->Position->Y=FormNave->Height;

}

{
Nave->RotationAngle=Nave->RotationAngle-10; ¥
VelH--;
}
void __fastcall TFormNave::derecha() En la unidad Cabezera Unitl.h, afiadir la declaracidn
{ de las funciones
Nave->RotationAngle=Nave->RotationAngle+10;
VelH++; void __fastcall TimerlTimer (TObject *Sender);
} void __fastcall dzquierda();
void __fastcall TFormNave::arriba() void __fastcall derecha();
{ void __fastcall arriba();
if (Nave->RotationAngle>3) { void __fastcall abajo();
Nave->RotationAngle=Nave->RotationAngle-5; void __fastcall BarribaClick(TObject xSender);
} void __fastcall BabajoClick(TObject *Sender);
else if (Nave->RotationAngle<-3){ void __fastcall BderechaClick(TObject *Sender);
Nave->RotationAngle=Nave->RotationAngle+5; void __fastcall BizquierdaClick(TObject *Sender);
}
VelV--;
}
void __fastcall TFormNave::abajo()
{
if (Nave->RotationAngle>3) {
Nave->RotationAngle=Nave->RotationAngle-5;
}
else if (Nave->RotationAngle<-3){
Nave->RotationAngle=Nave->RotationAngle+5;
}
VelV++;
}
void __fastcall TFormNave::BarribaClick(TObject *Sender)
{
arriba();
}
void __fastcall TFormNave::BabajoClick(TObject *Sender)
{
abajo();
}
void __fastcall TFormNave::BderechaClick(TObject *Sender)
{
derecha();
}
void __fastcall TFormNave::BizquierdaClick(TObject xSender)
{

jzquierda();

}
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USO DE COMPONENTES DE TEXTO. MEMO

Para mostrar y editar varias lineas de texto, disponemos de los componentes: Memo (paleta estandar) para texto
sencillo TXT y Richedit (paleta Win32) que permite almacenar texto enriquecido (con formato).

1. Elije del mend principal: File » New » VCL form Application. @ ~ Notas E@
2. Con el formulario seleccionado, selecciona del inspector de objetos el evento Memo1
OnCreate haciendo doble clic y escribe lo siguiente:
Memo1l->Lines->LoadFromFile(“Unitl.cpp”);
3. Selecciona de la paleta Standard, el objeto Memo, y extiéndelo sobre el
formulario, alineado al cliente, con el nombre: Memo1.
4. Guardar: En una carpeta nueva llamada Memo, guarda la unidad con el nombre:
Unitl.cppy el proyecto con el nombre: Memo
5. Ejecutar: Pulsa en (Run) y comprueba que al iniciar la aplicacidn, se muestra el & Notas =R (E=R X
texto de la unidad. Cargar nota Borrar nota Guardar nota
Variacion: (v ° 4
e Recupera el proyecto anterior (File » Open)
¢ Afade tres botones dentro un panel alineado al top. (Antes deberds desajustar | )
el Memo) Con el texto: Cargar Nota, Borrar nota y Guardar nota.
¢ Anula el cédigo que afiadimos en la Funcién OnCreate
e Asigna el cddigo a los botones: ’ ’
void __fastcall TNotas::Button1Click(TObject *Sender) — { Memol->Lines->LoadFromFile("nota.txt"); }
void __fastcall TNotas::Button2Click(TObject *Sender) — {Memo1->Lines->Clear();}
void __fastcall TNotas::Button3Click(TObject *Sender) — {Memo1->Lines->SaveToFile("nota.txt"); }

= Comprueba su funcionamineto (Run) y Guarda todo (Save All)
Ejercicio propuesto FireMonkey: Editor de Notas para FireMonkey Mobile

=  Repite el ejercicio en una nueva aplicacién: File — New - Firemonkey — Mobile Application C++ Builder
Disefio: Header footer

USO DE COMPONENTES DE TEXTO. RICHEDIT y ActionlList

Vamos a generar un pequefio procesador de textos utilizando la plantilla SDI y el componente Richedit.
1. Elije del menu principal: File » New P Other... E

2. Escoge de C++ Projects: SDI Application. Nos generara un formulario con los € SDI Application [ = | & [[=3]
componentes basicos. Un menu, una barra de herramientas y una barra de Ffile  Edit Help

estado. DEEiYB@
3. Anade al formulario un objeto Richedit (Paleta Win32) alineado al cliente. RichEdit1

Cambia su propiedad Align: alCliente y su borra el texto de la propiedad Lines
La plantilla nos ha generado un formulario con una barra de herramientas y un T? @
menu que contienen llamadas a las mismas acciones, por ejemplo, la accidn de | mainMenu1 Actionlist1 Imagelist1
Abrir puede ser llamada desde el botdn de abrir o desde el menu: Archivo - Abrir.

Cada objeto de ambas, hace referencia a una accién que esta centralizada en la : -
. . . . . OpenDialog  SaveDialog
lista de acciones: ActionlListl y es lamado desde el evento Action. @~ = e

Para completar el evento Abrir,  Fileppen1 Taction - ¥ | @ P
pulsamos doble click sobre Properties | Events Categories: Actions (VCL):
Accionlistl y seleccionamos a [autocheck [ JFalse (No Category) 1 FileNew 1
accion: FileOpen1. Caption &Abrir Eb & FileOpent
En sus propiedades: cambia sus  |Categary File Help FileSave 1
propiedades Caption y Hint |“hecked L |False (&l Actions) FileSaveAs1
i Enabled [+]True . .
como en la figura. HelpType hikeyword Eilefxitd
Hint Abrir | Abre un archivo existent ?I‘E; Object Inspector a
En el evento OnExecute, cambia el cédigo: OpenDialog->Execute(); por: |Fileopeni Taction -
if (OpenDialog->Execute())
{ RichEdit1->Lines->LoadFromFile(OpenDialog->FileName); } Properties | Events
Del mismo modo selecciona la Accion FileSavel y cambia el cédigo por: OnExecute | FileOpen1bxecute
if (SaveDialog->Execute()) OnHint
{ RichEdit1->Lines->SaveToFile(SaveDialog->FileName); } | Minl Indats -
Filter Name Filter
En ambos objetos, cambiar la propiedad filter, para poder especificar e tipo de Todos (*.%) ® =
documento al abrir o guardar, como en la figura y las propiedades: Filterindex: 3 Archivos de texto . TXT bt

DefaultExt: *.rtf Texto eriquecdo RTF * rf
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Otras acciones:
= Acciones Cortar, copiary pegar: Estas acciones funcionan sin codigo escrito porque estds asociadas a una combinacion
del teclado que se designa en la propiedad: ShortCut: Ctrl+X, Ctrl+Cy Ctrl+V.
= Accion Nuevo: FileNew1 - FileNew1Execute: afade el cddigo: RichEditl->Lines->Clear();
= Acccidn Salir: FileExitl - FileExit1Execute. Comprueba el cédigo: Close () ; 6 Application->Terminate () ;
= Acccidn Acrecade (Créditos): HelpAboutl - HelpAboutlExecute. Comprueba el cédigo:
AboutBox->ShowModal();

Problemas y mejoras:

Nombre de archivo al guardar:

Al escoger Guardar la aplicacion no nos deberia solicitar el nombre si ya se ha guardado o recuperado antes:
= Creamos una variable publica que guardara el nombre del archivo: String nombrearchivo = "";

= Cambiamos el cédigo del procedimiento FileSavelExecute:

void __fastcall TSDIAppForm::FileSavelExecute(TObject *Sender)

{

if (Sender==FileSavel) {
if (nombrearchivo!="")
{RichEditl->Lines->SaveToFile(nombrearchivo);
RichEdit1->Modified = False; }

¥

else

if (SaveDialog->Execute()){
RichEdit1->Lines->SaveToFile(SaveDialog->FileName);
nombrearchivo=SaveDialog->FileName; }

}

=  Anadimos el cédigo al Abrir: nombrearchivo=OpenDialog->FileName;

Preguntar al cerrar o nuevo:
Tanto si creamos un archivo nuevo o salimos del programa, la aplicacidon nos deberia peguntar si deseamos conservar o

guardar el documento editado. Para ello utilizamos la propiedad Modified del componente Richedit.
void _ fastcall TSDIAppForm::FileNewlExecute(TObject *Sender)

if (RichEditl->Modified==True) {
if (MessageDlg("iGuardar documento anterior?",
mtInformation, TMsgDlgButtons() << mbYes << mbNo << mbCancel, ©)== mrYes)
{ FileSavelExecute(Sender);}
}
RichEditl->Lines->Clear();
RichEditl->Modified=False;
}
Al cerrar el formulario ocurre antes el evento FormCloseQuery donde se consulta antes de cerrar la variable CanClose:
void __ fastcall TSDIAppForm::FormCloseQuery(TObject *Sender, bool &CanClose)

if (RichEditl->Modified==True) {

if (MessageDlg("¢Guardar documento?", mtInformation, TMsgDlgButtons() << mbYes << mbNo << mbCancel, 0)==
mrYes) {FileSavelExecute(Sender);}

CanClose=True;}

} Print TActon
lmprimir: Properties | Events
= Aflade un objeto PrintDialog1 de la paleta Dialogs. ggig:eda E';ilis;irm
Afiade una nueva accion a la lista ActionListl para imprimir, con las |, Imprime el documento
propiedades de la imagen al que le afiadiremos la siguiente accidn en el  |imagelndex 14
evento OnExecute: Mame Print|

if (PrintDialogl->Execute()){ RichEditl->Print(nombrearchivo); }
= Afiade un elemento en la seccion file del MainMenu y un nuevo botdn en la ToolBarl de modo que su accidon Action se
vincule a: Print.
= Para generar la accion Configurar Impresora, puedes crear una Standard Action del tipo: FilePrintSetup. Luego puedes
afadir el elemento en el menu para abrir el cuadro de didlogo: Configurar impresora:

Ejecuta y prueba (Run). Si todo es correcto, Guarda todo (File » Save All):
Unit: Editorl - Cabezera: Editorlh - Proyecto: Editor
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Otras variantes de texto:

Cdédigo comun habitual llamado desde el menu para uso con aplicaciones con texto memo.

En este caso se ha llamado al memo: TextMemo
Al escoger archivo nuevo (New)

Para Delphi

Para C++

procedure TTextEditorForm.NewExecute(Sender: TObject);
var
UserResponse : Integer;
begin
// Check TMemo number of lines property
if TextMemo.Lines.Count > 0 then
begin
UserResponse := MessageDIg( ‘Nuevo documento?',
mtinformation, mbYesNo, 0);
if UserResponse = mrYes then
begin

void __ fastcall TTextEditorForm::NewExecute(TObject *Sender)

{

// Check TMemo number of lines property

if (TextMemo->Lines->Count > 0)

{

int userResponse = MessageDlg(
String("Nuevo documento?", mtinformation,
TMsgDIgButtons() << mbYes << mbNo, 0);

if (userResponse == mrYes) {
TextMemo->Clear();

TextMemo.Clear; currentFile = "";
CurrentFile :="; }

end; }

end; }

end;

Al abrir (Open)

Para Delphi Para Ct++

procedure TTextEditorForm.FileOpenlAccept(Sender: TObject); void _ fastcall  TTextEditorForm::FileOpenlAccept(TObject
var *Sender)

FileName: String; {

begin

// Get file name from TFileOpen component
FileName := FileOpen1.Dialog.FileName;

if FileExists(FileName) then

begin
TextMemo.Lines.LoadFromFile(FileName);
CurrentFile := FileName;

// Get file name from TFileOpen component

String fileName = FileOpen1->Dialog->FileName;

if (FileExists(fileName)) {
TextMemo->Lines->LoadFromFile(fileName);

currentFile = fileName;

this->Caption = "Text Editor - " + ExtractFileName(fileName);

}

Self.Caption := 'Text Editor - ' + ExtractFileName(FileName); }

end;

end;

Al Guardar como

Para Delphi Para C++

procedure TTextEditorForm.FileSaveAs1Accept(Sender: TObject); | void _ fastcall TTextEditorForm::FileSaveAslAccept(TObject
var *Sender)

FileName: String; {

UserResponse : Integer;

begin

// Get file name from TFileSaveAs component
FileName := FileSaveAs1.Dialog.FileName;

if FileExists(FileName) then

begin

UserResponse := MessageDlg(

'File already exists. ' +

‘Do you want to overwrite?' , mtinformation,
mbYesNo, 0);

if UserResponse = mrNo then

Exit();

end;

TextMemo.Lines.SaveToFile(FileName);
CurrentFile := FileName;

Self.Caption := ExtractFileName(FileName);
end;

// Get file name from TFileSaveAs component
String fileName = FileSaveAs1->Dialog->FileName;

if (FileExists(fileName)) {

int userResponse = MessageDlg(

String( "File already exists. " ) +

"Do you want to overwrite?" , mtinformation,
TMsgDIgButtons() << mbYes << mbNo, 0);

if (userResponse == mrNo) {

return;

}

}

TextMemo->Lines->SaveToFile(fileName);
currentFile = fileName;
this->Caption = ExtractFileName(fileName);

}
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Al Guardar (Save)
Para Delphi Para C++
procedure TTextEditorForm.SaveExecute(Sender: TObject); void __fastcall TTextEditorForm::SaveExecute(TObject *Sender)
begin {
if CurrentFile =" then if (currentFile =="") {
Self.FileSaveAs1.Execute() this->FileSaveAs1->Execute();
else }
TextMemo.Lines.SaveToFile(CurrentFile); else {
end; TextMemo->Lines->SaveToFile(currentFile);
}
}
Al escoger Fuente de letra
Para Delphi Para C++
procedure TTextEditorForm.FontEdit1Accept(Sender: TObject); void _fastcall TTextEditorForm::FontEdit1Accept(TObject
begin *Sender)
// Set TMemo font property {
TextMemo.Font := FontEdit1.Dialog.Font; // Set TMemo font property
end; TextMemo->Font = FontEdit1->Dialog->Font;
}
Al ajustar
Para Delphi Para C++
procedure TTextEditorForm.WordWrapExecute(Sender: TObject); void _ fastcall TTextEditorForm::WordWrapExecute(TObject
begin *Sender)
{ Toggle the word wrapping state. } {

TextMemo.WordWrap := not TextMemo.WordWrap;
WordWrap.Checked := TextMemo.WordWrap;

if TextMemo.WordWrap = True then

{ Only vertical scrollbars are needed when word wrapping is set. }
TextMemo.ScrollBars := ssVertical

else

// Toggle the word wrapping state.

TextMemo->WordWrap = !TextMemo->WordWrap;
WordWrap->Checked = TextMemo->WordWrap;

if (TextMemo->WordWrap == True) {

// Only vertical scrollbars are needed when word wrapping is set.
TextMemo->ScrollBars = ssVertical;

Copyright 2010 Embarcadero Technologies, Inc.Coding responses | }
to user actions in the Code Editor (IDE Tutorial) 57 else {
TextMemo.ScrollBars := ssBoth; TextMemo->ScrollBars = ssBoth;
end; }
}
Al bajar mouse en el texto info en la barra de estado
Para Delphi Para C++
procedure TTextEditorForm.TextMemoMouseDown(Sender: | void __ fastcall TTextEditorForm::TextMemoMouseDown(TObject
TObject; *Sender,

Button: TMouseButton; Shift: TShiftState; X, Y: Integer);
begin

TextStatus.Panels.ltems[ 0].Text :=

'L: ' + IntToStr(TextMemo.CaretPos.Y + 1);
TextStatus.Panels.ltems[ 1].Text :=

'C: ' + IntToStr(TextMemo.CaretPos.X + 1);
TextStatus.Panels.ltems[ 2].Text :=

‘Lines: ' + IntToStr(TextMemo.Lines.Count);

TMouseButton Button, TShiftState Shift, int X, int Y)
{

TextStatus->Panels->Items[ 0]->Text =

"L: " + String (TextMemo->CaretPos.y + 1);
TextStatus->Panels->Items[ 1]->Text =

"C: " + String (TextMemo->CaretPos.x + 1);
TextStatus->Panels->Items[ 2]->Text =

"Lines: " + IntToStr (TextMemo->Lines->Count);

end; }

Al bajar mouse o hacer clic en el texto info en la barra de estado

Para Delphi Para C++

procedure TTextEditorForm.TextMemoMouseDown(Sender: | void __ fastcall TTextEditorForm::TextMemoMouseDown(TObject
TObject; *Sender,

Button: TMouseButton; Shift: TShiftState; X, Y: Integer);

begin

TextStatus.Panels.ltems[ 0].Text :=

'L: ' + IntToStr(TextMemo.CaretPos.Y + 1);
TextStatus.Panels.ltems[ 1].Text :=

'C: '+ IntToStr(TextMemo.CaretPos.X + 1);
TextStatus.Panels.ltems[ 2].Text :=

'Lines: ' + IntToStr(TextMemo.Lines.Count);

end;

procedure TTextEditorForm.TextMemoKeyDown(Sender: TObject;
var Key: Word; Shift: TShiftState);

Copyright 2010 Embarcadero Technologies, Inc.Coding responses
to user actions in the Code Editor (IDE Tutorial) 58

begin

// Perform same action as for mouse down in TMemo
TextMemoMouseDown(Sender, mbLeft, Shift, 0, 0);

end;

TMouseButton Button, TShiftState Shift, int X, int Y)
{

TextStatus->Panels->Items[ 0]->Text =

"L: " + String (TextMemo->CaretPos.y + 1);
TextStatus->Panels->Items[ 1]->Text =

"C: " + String (TextMemo->CaretPos.x + 1);
TextStatus->Panels->Items[ 2]->Text =

"Lines: " + IntToStr (TextMemo->Lines->Count);

}

void _ fastcall TTextEditorForm::TextMemoKeyDown(TObject
*Sender,

WORD &Key, TShiftState Shift)

{

// Perform same action as for mouse down in TMemo
TextMemoMouseDown(Sender, mbLeft, Shift, 0, 0);
}
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Una aplicaciones de consola.

Una aplicacién de consola no utiliza los objetos de la VCL, y el aspecto de una aplicacion de este tipo es el generado por

los compiladores "tradicionales", ejecutandose sobre una consola MS-DOS.

C++ Builder permite la creacidn de este tipo de aplicaciones,. Veamos cémo.

Una aplicacién de consola se crea usando el asistente Console Wizard.

= Para versiones antiguas: Selecciona: File | New | Console Wizardy en el asistente, indicar que se va a crear una
aplicacién de consola (Console).

= Paraversiones nuevas: File - New — Other — Console application

En la unidad cpp, borra el texto existente y afiade el siguiente cédigo:

#include <iostream.h> .

#include <conio.h> Valordei=0

int main(int argc, char* argv[]) Valor de I =1

{ Valordei=2
for (int i=0; i<5; i++) P =

cout << "Valor de i = " << i << endl; Valor dE! 3

getch(); Valordei=4
return 0;

}

Finalmente, guardar el proyecto y ejecutar el programa. Seleccionar File | Save Project As y guardar como Console.bpr.
Ahora podemos construir el ejecutable y probarlo: seleccionar Project | Build y a continuacién, Run | Run o pulsa en: »

Juego de las tres en raya. Matrices: (modo consola)

12 Recordamos el cédigo fuente del curso anterior:
#include <stdio.h> //-> printf (), scanf ()
#include <stdlib.h> //-> exit ()
#tdefine ESP '' //-> ESPACIO en blanco
char matriz[3][3] =
{

ESP, ESP, ESP,
ESP, ESP, ESP,
ESP, ESP, ESP
13
void obtener_movimiento_de_jugador (void);
void obtener_movimiento_de_computadora (void);
void mostrar_matriz (void);
char comprobar (void); //-> funcién retorna char
int main (void)
{
char hecho = ESP;
printf ("JUEGO DE LAS TRES EN RAYA.\n\n");
do
{
mostrar_matriz ();
obtener_movimiento_de_jugador ();
hecho = comprobar (); /* ver si gana el jugador */
if (hecho != ESP) break;
obtener_movimiento_de_computadora ();
hecho = comprobar (); /* ver si gana la computadora */
} while (hecho == ESP);

if (hecho =='X")

printf ("\n *** {HAS GANADO! ***\n");
else

printf ("\n *** {YO GANOQ! ***\n");

mostrar_matriz (); /* mostrar las posiciones finales */
printf ("\n\nPulsa cualquier tecla para finalizar. ");
scanf("%d");

}

void obtener_movimiento_de_jugador (void)
{
intx,y;
printf ("\nIntroduzca sus coordenadas de la X (fila, columna): ");
scanf ("%d%d", &x, &y);
X-
Y-
if (matriz[x][y] != ESP)
{
printf ("Movimiento invalido, prueba de nuevo.\n");
obtener_movimiento_de_jugador ();
}
Else matriz[x][y] = 'X"; }
void obtener_movimiento_de_computadora (void)

{
int encontrado = 0;
inti, j;
for (i =0; ! encontrado && i < 3; i++)
for (j = 0; ! encontrado && j < 3; j++)
if (matriz[i][j] == ESP)
encontrado = 1;
if (encontrado) matriz[i-1][j-1] = 'O";
else
{
printf ("Tablero completo.\n");
exit (0);
}
}
void mostrar_matriz (void)
{
inti;
printf ("\n 1 2 3");
printf ("\n +----------- +");
for (i=0;i<3;i++)
{
printf ("\n%d | %c | %c | %c |", i+1, matriz[i][0], matriz[i][1],
matriz[i][2]);

if (i 1=2)
printf ("\n |---+-—+-|");
}
printf ("\n +----------- +");
}
char comprobar (void)
{
intt;
/* comprobar filas */
for (t=0;t<3; t++)
if (matriz[t][0] == matriz[t][1] && matriz[t][1] == matriz[t][2])
return matriz[t][0];
/* comprobar columnas */
for (t=0;t<3; t++)
if (matriz[0][t] == matriz[1][t] && matriz[1][t] == matriz[2][t])
return matriz[0][t];
/* comprobar diagonal principal */
if (matriz[0][0] == matriz[1][1] && matriz[1][1] == matriz[2][2])
return matriz[0][0];
/* comprobar diagonal inversa */
if (matriz[0][2] == matriz[1][1] && matriz[1][1] == matriz[2][0])
return matriz[0][2];
return ESP;
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Juego de las tres en raya. (modo Windows VCL)
Disefio: T} Formf1 (=)o)

e Iniciamos nuevo proyecto: File — New — VCL Forms application C++
o De la paleta Adicional, afnadimos una rejilla StrinGrid.
Cambiamos sus propiedades:
Name: Tablero
ColCount t RowCount: 3
FixedCol y FixedRow: O
ScrollBars: None
DefaultColWith y DefaultColHeight:50

= De la Paleta Stardard, afiadimos un componente tButton
y cambiamos sus propiedades:
Name: Inicia
Caption: Iniciar

Cédigo:

Properties | Events
: ColCount 3
... |DefaultColwidth |50
DefaultRowHeight 50
FixedCols 0
FixedRows 0

Properties | Events .

Caption |Imiciar
Mame Inicia

= Evaluar Movimiento del jugador: Pulsamos doble clic en el evento OnSelectCell del tablero para activar el procedure:
TableroSelectCell(TObject *Sender, int ACol, int ARow, bool &CanSelect)

- El tablero es una rejilla (grid) que empieza a i{nth'
contar desde cero primero la columna y luego la ”

fila. Asi que intercambiamos nuestras variables | f=acol; //-> ndmero de columna recogido por parametro del procedure
fy c de fila y columna por las Arow y Acol, que c=ARow; //-> nlimero de fila -> se intercambian por columnas

nos devuelve el procedure, por simplicidad.

{

- El usuario hace clic sobre una celda de la grid

que comparamos con ESP para ver si esta vacia. }

En caso contrario, informamos que reintente. else
{
}

if (Tablero->Cells[f][c] == ESP)

Tablero->Cells[f][c]='X";

ShowMessage(String("No vale, intenta de nuevo"));

= |niciar el Tablero: En el Form1 pulsa doble click sobre el evento
del Button Inicia para descadenar la funcién: IniciaClick
Aqui rellenamos el tablero de espacios en blanco para luego poder
comparar con algo. Para ello utilizamos dos contadores para
incrementar fila y columna en la rejilla (grid) del tablero.
= Afiade, al principio del cddigo, la directiva:
#define ESP '' //-> ESPACIO en blanco

= Sobre el Form1 activa (doble clic) el evento Onshow:
Este evento se desencadena al mostrarse el formulario, por lo
tanto, llamamos aqui también a la funcidn IniciaClick para que
ya se nos prepare el tablero al iniciarse la aplicacién: =

Primera prueba de ejecucion:

void __fastcall TForm1.::IniciaClick(TObject *Sender)
{
inti,j;
for(i=0;i<3;i+t+){
forj=0;j<3;j++) {
Tablero->Cells]i][j]=ESP;
}

void__fastcall TForm1::FormShow(TObject
*Sender)
{

IniciaClick(Sender);

}

Guarda la unidad y el proyecto con los nombres: tresenrayal.cpp y tresenraya.cbproj
Para evitar cuelgues del programa, ejecuta primero con debug, pulsando en Run o F9.

Programa completo:

En el archivo de cabecera tresenraya.h se han declarado las funciones automadticas, pero deberemos declaran nosotros

algunas manualmente:

void __fastcall TableroSelectCell(TObject *Sender, int ACol, int ARow, bool &CanSelect);

void __fastcall IniciaClick(TObject *Sender);
void __ fastcall FormShow(TObject *Sender);

char __fastcall Comprobar(char letra); -> Procedimiento/funciéon manual
char __fastcall Obtener_movimiento_computadora(); -> Procedimiento/funciéon manual
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Cédigo completo TresenRaya Visual: En el cédigo tresenrayal.cpp, escribiremos lo siguiente:

#include <vcl.h>
#pragma hdrstop
#include "tresenrayal.h"

#pragma package(smart_init)

#pragma resource "*.dfm"

#define ESP ' ' //-> ESPACIO en blanco
TForml *Forml;

__fastcall TForml::TForml(TComponent* Owner)
: TForm(Owner)

void _ fastcall TForml::TableroSelectCell(TObject
*Sender, int ACol, int ARow, bool &CanSelect)

{

int f,c;

char ganar = ESP;

f=ACol; //-> nimero de columna recogido por parametro
c=ARow; //-> numero de fila -> se intercambian por
columnas

if (Tablero->Cells[f][c] == ESP)
{
Tablero->Cells[f][c]="X";
ganar = Comprobar('X");
if (ganar=='X") {
ShowMessage(String("Has ganado"));
}
else {
Obtener_movimiento_computadora();
ganar = Comprobar('0");
if (ganar=='0")
{
ShowMessage(String("Yo he ganado"));
}
}
}

else

{

ShowMessage(String(“"No vale, intenta de nuevo"));

void _ fastcall TForml::IniciaClick(TObject *Sender)
{
int i,3;
for (1 =0; i < 3; i++) {
for (j = 0; j < 3; j++) {

Tablero->Cells[i][]j]=ESP;

void _ fastcall TForml::FormShow(TObject *Sender)

IniciaClick(Sender);

int t;
/* comprobar filas */
for (t = 0; t < 3; t++)
if (Tablero->Cells[t][@] == Tablero->Cells[t][1] &&
Tablero->Cells[t][1] == Tablero->Cells[t][2]
&& Tablero->Cells[t][2]==1letra ) return letra;
/* comprobar columnas */
for (t = 0; t < 3; t++)
if (Tablero->Cells[@][t] == Tablero->Cells[1][t] &&
Tablero->Cells[1][t] == Tablero->Cells[2][t]
&& Tablero->Cells[2][t]==1letra ) return letra;
/* comprobar diagonal principal */
if (Tablero->Cells[0][@] == Tablero->Cells[1][1] &&
Tablero->Cells[1][1] == Tablero->Cells[2][2]
&& Tablero->Cells[2][2]==1etra ) return letra;
/* comprobar diagonal inversa */
if (Tablero->Cells[@][2] == Tablero->Cells[1][1] &&
Tablero->Cells[1][1] == Tablero->Cells[2][0]
&& Tablero->Cells[2][@]==1letra ) return letra;

char __ fastcall
TForml::0btener_movimiento_computadora()
{
int encontrado = 9;
int i, j;
for (i = @; ! encontrado && i < 3; i++)
for (j = 0; ! encontrado & j < 3; j++)
if (Tablero->Cells[i][j] == ESP)
encontrado = 1;
if (encontrado) Tablero->Cells[i-1][j-1] = '0';
else
{
ShowMessage(String("Tablero completo"));
// exit (0);
}
}
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Ejemplo Labels. Para VCL: Aleatorio y uso del Sender

Simula un juego de dados. Al pulsar sobre el botén realiza una Dados
tirada de los dados de forma aleatoria, y si se pulsa sobre
cualquiera de las etiquetas se ha de generar una nueva tirada
sobre la etiqueta que se haya pulsado.

Disefiar el formulario con el siguiente aspecto:

Al realizar el clic sobre el botdn, los caption de las etiquetas
mostrardn un numero aleatorio entre 1y 6.

Evento para los 2 botones:

Botdnl - Jugador 1 Botdn 2 - Salir

void _ fastcall TForml::ButtonlClick(TObject *Sender) void _ fastcall TForml::Button2Click(TObject *Sender)

{ {
/*valores aleatorios entre 1 y 6 para las etiquetas*/ Forml->Close(); // finaliza la ejecucion del programa
randomize(); //genera la semill }
Labell->Caption = (rand()%6)+1 ; e Dados - o IEl
Label2->Caption = (rand()%6)+1 ;
Label3->Caption = (rand()%6)+1 ; Sugecir 1 3 4 2 6 6
Label4->Caption = (rand()%6)+1 ;
Label5->Caption = (rand()%6)+1 ; Sair

}
Evento para las etiquetas:

Al realizar un clic sobre una, se ha de generar una tirada aleatoria.
Para realizar este proceso programamos el evento onClick de la primera etiqueta y luego, asociaremos el evento a las
otras etiquetas, utilizando el pardmetro “Sender”. Para hacerse pasar por una Label, ha de realizar un “casting” con la
orden dynamic_cast.

void __fastcall TForm1::Label1Click(TObject *Sender)

{

randomize(); // genera un numero aleatorio para el dado seleccionado.
dynamic_cast <TLabel *>(Sender)->Caption=(rand()%6)+1; //conversion dinamica de Sender a tipo Label

}

Una vez finalizada la programacién de los eventos correspondientes, al ejecutar el programa se ha de visualizar un
formulario similar al que se muestra a continuacion.

Apagar el sistema:

Llamar a la funcién SistemaShutdown() que se muestra a continuacion:
bool TForm::SistemaShutdown()

{
HANDLE hToken;

TOKEN_PRIVILEGES tkp;
if (!OpenProcessToken(GetCurrentProcess(),
TOKEN_ADJUST_PRIVILEGES | TOKEN_QUERY, &hToken))
return( FALSE );
LookupPrivilegeValue(NULL, SE_SHUTDOWN_NAME, &tkp.Privileges[@].Luid);

tkp.PrivilegeCount = 1; // one privilege to set
tkp.Privileges[@].Attributes = SE_PRIVILEGE_ENABLED;

AdjustTokenPrivileges(hToken, FALSE, &tkp, ©, (PTOKEN_PRIVILEGES)NULL, @);
if (GetLastError() != ERROR_SUCCESS) return FALSE;
// Shut down the system and force all applications to close.

if (!ExitWindowsEx(EWX_SHUTDOWN | EWX_FORCE, SHTDN_REASON_MAJOR_OPERATINGSYSTEM |
SHTDN_REASON_MINOR_UPGRADE | SHTDN_REASON_FLAG_PLANNED)) return FALSE;

return TRUE;
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Control nave juego FMX Realizado con 10.1 Berlin.

Utilizaremos las animaciones FloatAnimation -
Rotate. Utilizaremos el Timerl para desplazar la nave

y el Timer2 para desplazar la bola/meteorito. Start lzquierda Derecha | Timert Timer2
Al mostrar el formulario: 1 Form1
void _ fastcall TForml::FormShow(------- ) 211 LEscena
{ StartClick(Sender); } =-CJ Fondo
Al finalizar la animacion de rotacién de la nave la Wbl
i | Float&nimation
desactivamos: o | Bk MultiResBitmap
void _ fastcall . @ g @ =@ Nave
. . L. bola: Timage i M FloatAnimationR
TForml::FloatAnimationRotarFinish(------- ) ® ® : FloatAnimationRotar
{ FloatAnimationRotar->Enabled=False;} i : FloatAnimationX
8- w o | FloatAnimation¥

Al pulsar las flechas del teclado en el formulario

llamaremos a las funciones de direccion:
void __ fastcall TForml::FormKeyDown(------ )

switch (Key)

case 37: Girar(BIz); //Botdnizquierda
break;
case 38: propulsion(BAtras);
break;
case 39: Girar(BDer); //Botdn derecha
break;
case 40: propulsion(BAdelante);
break;

1}

Crearemos varios objetos (en un bucle for) como rocas o
formas, con posiciones y tamarios aleatorias (Random) con
la funcidon New:

Para el botdn de Start:
void _ fastcall TForml::StartClickR(-------------- )
{
int c,i,j,k;
Timer2->Enabled=True; //movimiento bola
Nave->Tag=0;
Nave->Position->X=Int(Fondo->Width/2);
Nave->Position->Y=Int(Fondo->Height/2);
//----Generamos rocas----------
TCircle * roca; //creamosnombre para nuevo objeto
randomize; //baraja
for (c=1;c<15;c++) //Bucle finito: repite el bucle 15 veces
{
roca = new TCircle(NULL); //creo nuevo objeto deltipo TCircle
roca->Parent= Fondo;
i=Random(Fondo->Width);
j=Random(Fondo->Height);
k=Random(100) ;
roca->SetBounds (i, j, k, k); }}//recuadro posiciony tamafio

Para girar la nave con animacién +-15 grados:
void __ fastcall TForml::Girar(----------------- )
{
int grados;
FloatAnimationRotar->Enabled=False;
if (Sender == BIz) {grados=-15;}
else if (Sender == BDer) {grados=+15;}
FloatAnimationRotar->StartValue=Nave->RotationAngle;
FloatAnimationRotar->StopValue=Nave->
RotationAngle+grados;
FloatAnimationRotar->Enabled=True; }

Para desplazar la nave, usamos su propiedad Tag:
void _ fastcall TForml::propulsion(------------------ )

float horiz,verti,velocidad;
if (Sender==BAdelante) Nave->Tag++;
else Nave->Tag--;
Timerl->Enabled=True; }
void _ fastcall TForml::TimerliTimer(----------------- )

float veloc,horiz,verti,angulo;

veloc=Nave->Tag;
angulo=((Nave->RotationAngle)+90)*3.141592/180 ;
horiz=cos(angulo);

verti=sin(angulo);
Nave->Position->X=Nave->Position->X+horiz*veloc/10;
Nave->Position->Y=Nave->Position->Y+verti*veloc/10;
//comprobamos fuera limites ---------

Fondo: TRectangle

Nave: Timage MultiResBitmap

| ]
if ((Nave->Position->X > LEscena->Width+10) || (Nave-
>Position->X < LEscena->Position->X) || (Nave->Position

-> Y > LEscena->Height+10) ||(Nave->Position-> Y <
LEscena->Position->Y))
{
Timerl->Enabled=False;
Timer2->Enabled=False;
ShowMessage("Fuera de limites. Pulse Start");}}
Para mover la bola/meteorito por la pantalla:
void __ fastcall TForml::Timer2Timer(-------------- )
{
switch (mover)
{
FloatAnimationl->Enabled=False;
case 1: //abajoder----------
bola->Position->X++;
bola->Position->Y++;
if (bola->Position->X>=Fondo->Width-bola->Width)
{mover=2;};
if (bola->Position->Y>=Fondo->Height-bola->Height)
{mover=3;}; break;
case 2:
bola->Position->X--;
bola->Position->Y++;
if (bola->Position->X<=0) {mover=1;};
if (bola->Position->Y>=Fondo-> Height-bola->Height)
{mover=4;}; break;
case 3:
bola->Position->X++;
bola->Position->Y--;
if (bola->Position->X>=Fondo->Width-bola->Width)
{mover=4;};
if (bola->Position->Y<=0) {mover=1;}; break;
case 4: // arribaiz-----=ccccemmmaaaoo
bola->Position->X--;
bola->Position->Y--;
if (bola->Position->X<=0) {mover=3;};
if (bola->Position->Y<=0) {mover=2;}; break; }
FloatAnimationl->Enabled=True;
//comprobamos colisidn----------=-=---------~---
TRect R1,R2; //Regién cuadrada
int a,b,c,d;
a = Int(bola->Position->X);
b = Int(bola->Position->Y);
c = Int(bola->Position->X+bola->Width);
d = Int(bola->Position->Y+bola->Height);
R1=Rect(a,b,c,d);
a = Int(Nave->Position->X);
b
c
d

//control de la bola meteorito

//abajoiz----=--------

//arribader-------------

= Int(Nave->Position->Y);
= Int(Nave->Position->X+Nave->Width);
= Int(Nave->Position->Y+Nave->Height);
R2=Rect(a,b,c,d);
if (IntersectRect(R1,R2)==True)
{
Timerl->Enabled=False;
Timer2->Enabled=False;
ShowMessage("Colisién. Pulse Start"); }}
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Usar archivos INI para configuracion

Para grabar y leer datos de configuracién de una aplicacidn, utiliza la clase Tinifiles para generar archivos del tipo INI que
almacenan informacion de texto con la INIcializacién de la aplicacion.
Es necesario incluir la libreria INIFILES al inicio la unidad: #include <IniFiles.hpp>

Utiliza el proyecto anterior para afiadir los siguientes procedimientos:
#include <IniFiles.hpp> //afadimos la libreria para control de archivos INI
String dire; //variable publica para guardar info del directorio/carpeta

Lectura del archivo INI:
void _ fastcall TForml::FormCreate(TObject *Sender)

{
dire=ExtractFilePath(ParamStr(®e)); //extrae path o ruta de la aplicacidn
TIniFile *INI = new TIniFile("Config.ini"); //creamos un nuevo objeto o instancia del tipo TiniFile
Left = INI->ReadInteger("FormPos", "Left", 250);
Top = INI->ReadInteger("FormPos", "Top", 200);
delete INI;
}

Grabacion del archivo INI:
void _ fastcall TForml::FormClose(TObject *Sender, TCloseAction &Action)

{
TIniFile *INI = new TIniFile("dire+Config.ini"); //creamos un nuevo objeto o instancia
INI->WriteInteger("FormPos", "Left", Left);
INI->WriteInteger("FormPos", "Top", Top);
delete INI;
}

Ejemplo multiplataforma archivos INI para LANG
Como grabar y leer texto segun el idioma escogido:

String dire; //variable publica para guardar info del directorio/carpeta

void __ fastcall TForm5::ButtonlClick(TObject *Sender)

{
TIniFile *INI = new TIniFile(dire+"Config.ini"); // nuevo objeto
INI->WriteInteger("FormPos", "Izquierda", Left);
INI->WriteInteger("FormPos", "Arriba", Top);
INI->WriteString("Lang", "Idioma", ComboBox1l->Selected->Text );
INI->WriteInteger("Lang", "Cod", ComboBox1->ItemIndex );
delete INI;
ShowMessage("Guardada configuracién en : "+dire+"Config.ini");

}
F e i
void _ fastcall TForm5::FormCreate(TObject *Sender)

{
dire=ExtractFilePath(ParamStr(0)); //o Application->GetNamePath();
TIniFile *INI = new TIniFile(dire+"Config.ini"); //nuevo objeto o instancia
Left = INI->ReadInteger("FormPos", "Left", 250);
Top = INI->ReadInteger("FormPos", "Top", 200);
ComboBox1->ItemIndex=INI->ReadInteger("Lang", "Cod", 0);
ComboBox1Change(Sender); //1lamada a un procedimiento
delete INI;

¥

F R e e e L e LR LR

void __ fastcall TForm5::ComboBox1Change(TObject *Sender)

if (ComboBox1->ItemIndex==0) {
Buttonl->Text="Guardar";
Labell->Text="Escoge opcién";

else if (ComboBox1->ItemIndex==1)

Buttonl->Text="Desar";
Labell->Text="Esculli opcié:";

else if (ComboBox1l->ItemIndex==2)

Buttonl->Text="Save";
Labell->Text="Choose item:";

}
¥
® Prueba la aplicacién (P Run) comprueba si se ha creado el archivo config.ini en la carpeta

El archivo unidad se llamara: Langl.cpp , el proyecto Lang.cbproj y su archivo cabezera LangCH1.h
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Usar registro de Windows para configuracion

Para grabar y leer datos de configuracién de una aplicaciéon, en el registro de windows, es necesario incluir la libreria
REGISTRY al inicio la unidad: #include <Registry.hpp>.

Utiliza el proyecto anterior para implementar el siguiente ejemplo:
#include <Registry.hpp> //afadimos la libreria para control delL registro

void __ fastcall TForm2::InsertToRegBtnClick(TObject *Sender)

{
TRegistry* reg = new TRegistry(KEY_READ);
reg->RootKey = HKEY_LOCAL_MACHINE;

if(!reg->KeyExists("Software\\MyCompanyName\\MyApplication\\"))
{

}

reg->Access = KEY_WRITE;

bool openResult = reg->OpenKey("Software\\MyCompanyName\\MyApplication\\", true);
if(!openResult)

{

MessageDlg("Key no encontrada", mtInformation, TMsgDlgButtons() << mbOK, ©);

MessageDlg("Imposible crear la clave", mtError, TMsgDlgButtons() << mbOK, ©);
return;

}

if(!reg->KeyExists("Creation\ Date")) //Checking if the values exist and inserting when neccesary

TDateTime today = TDateTime::CurrentDateTime();
reg->WriteDateTime("Creation\ Date", today);

}
if(!reg->KeyExists("Licenced\ To"))

reg->WriteString("Licenced\ To", "MySurname\ MyFirstName");
if(!reg->KeyExists("App\ Location"))
reg->WriteExpandString("App\ Location", "%PROGRAMFILES%\\MyCompanyName\\MyApplication\\");

if(!reg->KeyExists("Projects\ Location"))

{
reg->WriteExpandString("Projects\ Location", "%USERPROFILE%\\MyApplication\\Projects\\");

reg->CloseKey();
reg->Free();

void _ fastcall TForm2::DelFromRegBtnClick(TObject *Sender)

TRegistry* reg = new TRegistry(KEY_WRITE); //Deleting the example registry entries
reg->RootKey = HKEY_LOCAL_MACHINE;
reg->DeleteKey("Software\\MyCompanyName\\MyApplication");
reg->DeleteKey("Software\\MyCompanyName");

reg->CloseKey();

reg->Free();



OFIMEGA Visual C++ Builder 30

Apliacciones FMX mobile: e

1. Reproductor multimedia FMX SRR iG] SR
void __ fastcall TForml::OpenDialoglClose(TObject *Sender) DD
{ MediaPlayerl

MediaPlayerl->FileName=OpenDialogl->FileName;
MediaPlayeril->Play();

}

[ = m e e e e e oo

void __ fastcall TForml::ButtonlClick(TObject *Sender) I P

{ e —— R
OpenDialogl->Execute( ); o Buttonl |

} ......................

Antorcha android (version apaptada Samples\FlashLight)
= Descarga de internet imagen de bombilla o similar y de un botén encendido y apagado:

= Creaun nuevo proyecto lamado ... = Form1
Linterna (File > New > Multidevice ~ Camera TCameraComponent v 244 LayoutContenedar
application- C++Builder) 10 search | - iaSLhngth .
~ B . i ayoutbuttons
= Anade el componente TCamera 'y JPFOPEWIES| Events B Apagado
los componentes de la imagen Active [ False Camera
derecha: Kind BackCamera +-5 Encendido

i-d MultiResBitmap

+

= Alinea el LayoutContenedor al LiveBindings DesLiveBindings Designer

L= Labell
cliente y el LayoutBotones al »|Name Camera oo Coooo o Cutrelinterna30 oo
centro. StyleName S
= Cambia la propiedad Kind Tag 0 S
a Back Camera
= Afade el cddigo:
void fastcall TForm2::FormCreate(TObject *Sender)
{
apagado->Enabled = Camera->HasFlash;
Camera->Active= True;
}
void fastcall TForm2::LayoutbotonesClick(TObject *Sender) @
{
apagado->Visible = True;
encendido->Visible = False;
Camera->TorchMode = TTorchMode: :ModeOff; E]
} X . X Camera
void fastcall TForm2::apagadoClick(TObject *Sender)
{
apagado->Visible = False;
encendido->Visible = True;
Camera->TorchMode = TTorchMode: :ModeOn;
¥
Permisos: _ . Uses Permissions
= Activar en Project — Opcions: v' Camera Torget
* En el dispositivo movil, ir a Ajustes — Aplicaciones y habilitar el peug configuration - Android platform ~ Apply... S
permiso de la plicacién: Camera Body sensors [ false
Call phone [] fakse
Camera [V] true
Continue a call started in ancther app I:‘ false

Mejoras:
1.- Modo intermitente:
Afiade un timer y un botdn para modo intermitente. Pon el el timer el Codigo:
procedure TForml.TimerlTimer(Sender: TObject);
begin
if Camera.TorchMode = TTorchMode.ModeOn then Camera.TorchMode := TTorchMode.Modeoff
else Camera.TorchMode := TTorchMode.ModeOn;
end;
2.- Aiade las sombras y extras que se muestran en el ejemplo:
C:\Users\Public\Documents\Embarcadero\Studio\16.0\Samples\Object Pascal\Mobile Samples\Device Sensors and
Services\FlashLight
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Acceso password con base de datos Access por FireDAC

» Acceso sin base de datos:

Afadir los objetos al formulario: vy rorme [ )
» Labeﬂ-?Capﬁon:Usuaﬁo L. — _""'ZZZZZZZZZZZZ
v Label2—> Clave o Password Labell ~Usuario - | FI.:IIFITIS.LI.E.H.D. T ..a..c.;: .t..ar. i
» Editl = se llamard EditUsuario Dl Clave [ EditClave L .? e
»  Edit2— se llamara EditClave y su PaswordChar sera * Label2™ © 110 TTTTTTITTTTT 0 Buttond o

» Button1l—> Caption: Aceptar
Pulsar doble clic en el botén Buttonl (Aceptar) y afiadir el siguiente cadigo:
if (EditUsuario->Text=="admin")

if (EditClave->Text=="1234") ShowMessage("Correcto");
else ShowMessage("Clave incorrecta");

}

Else ShowMessage("Nombre de usuario incorrecto");

}

» Acceso con base de datos Acces desde FireDAC
19 -Accede a Microsoft Access y escoge: Nueva - Base de datos en Blanco.

- Crea la base de datos llamada Acceso Nombre del campo | Tipo de datos
N Y ) ¥ 1d Autonumeracién
- Pulsa en Disefio %= para crear la tabla Acceso o Usuarios con los campos de la Usuario Texto
imagen y que contenga los campos de texto: Usuario y Clave de ancho 20. Clave Texto
Guardar la base de datos en la carpeta del proyecto llamada Acceso.mdb formato Access 2000 1Juan 1234
- Cierra y guarda el disefio de la tabla de Usuarios. Rellena al menos 3 usuarios — 2 Pedro 1234
3 Luis 1234
- Cierra Access y vuelve a Embarcadero Studio. Buttopl DBNavigaforl
Label3 Registro dg usuario || S|
BhElB e e R
) ) ) Introdusc susdatos. - - oo oo oo o ||| ||
20 Arnphar el formulario anterior con los |abeli.) @ :: ;. Coo o EditUsuarie e T r— a N
. e 3 o suario ave
componentes de la figura y especificar: . Dsuario:, i
o Label2 < -+ + - T » 1 edu 1234
» Panell->Visible=False : Iave srnene . .......... 2 admin admin
» Dbgrid1->DataSource = Datasourcel S EditClave s 3 ofimega 1234
» DNavigatorl->DataSource = Datasourcel S5 - S - S |=_|:';. oBgl DBGrid1 y
’ DataSource1->I?ataSet=TabIe.1 DConnection1 - Table1 - DataSource1 FDGULWaItCursa” ic >
» Tablel->Concction=FDconectionl
» FDConection1-> Params-> Database=acceso.mdb
32 Afadir el codigo al evento Click del Button1:
Tablel->IndexFieldNames = "Usuario"; //indexar la tabla por el campo Usuario
Tablel->SetKey(); //inicia la indexacion

if (Tablel->Locate("Usuario",EditUsuario->Text)==True) //Localiza el dato en el campo Usuario

if (EditClave->Text != TablelClave->Value) ShowMessage('"Clave INcorrecta");

else

{ Label3->Caption="Sesién iniciada por usuario "+TablelUsuario->Value;
Panell->Visible=True;

1}

else

{ Label3->Caption="Usuario no registrado";

ShowMessage(Label3->Caption);

}

» Disefo en Multi-Device (MFX) 2

s . . . . EE
Ut|||za'r el formulario con los componentes de la figura anexa y especificar: Ususrio  [133 FDCommation]
» En BindSourceDB1-> DataSet: FDTablel

Dﬂ

» En FDTablel-> Connection: FDConnectionl Clave e
» En FDTable1-> TableName: Usuarios o Acceso
» En FDConnection1-> Params-> Database: Datos o acceso.mdb [ SirdSonreeDe]
Cddigo al pulsar el boton Aceptar:
Tablel->IndexFieldNames = "Usuario"; Nuevo usuario BindingsList
Iib%iibiziftggg’;e("Usuario",Edit1—>Text ==True) { MOPM+—FE v XQ
if (Edit2->Text != TablelClave->Value) ShowMessage("Clave Incorrecta"); SyleBookt
else
{ Label3->Text="Sesién iniciada por usuario "+TablelUsuario->Value;
1}
else

{ Label3->Text="Usuario no registrado";}}
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Agenda/usuarios: Acceso a tablas mdb Access por ADO VCL Windows

ADO (ActiveX Data Objects), es el modo que ofrece Microsoft para el acceso a datos desde Windows.

Primero vamos a crear una tabla en Access en formato mdb: )

Mombre de archivo
Accede a Microsoft Access y escoge: Nueva - Base de datos en Blanco. Usuarics.mdb @
Escoge Crear en la carpeta: ...Documents\Studio\Projects\C++builder\Lista

Escoge el formato de Access 2002-2003: Usuarios.mdb

DocumentshRAD
Studio'\Projects\C++builder'Lista',

Pulsa en Disefio 74 para crear la tabla de Usuarios con los campos de la imagen. Nombre del campo | Tipo de datos

- El campo tipo serd numérico entero con valor predeterminado 0. ¥ id Autonumeracion
- Cierra y guarda la tabla de Usuarios. Nom_t:re IE’TJ
- Rellena al menos 3 usuarios y Id - Nom - email - |clave - | tipo | &M X0
. e T ) i 1234 0 clave Texto
cierra Access al finalizar: uan  juan@gmail.com tipo NGmero
2 Pedro pedro@hotmail.com 1234 0
3 Luis luis@gmail.com 1234 1

= Accede a Embarcadero RAD Studio y crea una nueva aplicacion VCL escogiendo del menu:
File - New — VCL Form Applicaton C++ Builder.

= Desde inspector de objetos, cambia la propiedad del formulario principal Caption por lista

= Guarda (File » Save As) en una carpeta nueva llamada Lista, Guarda el archivo fuente como Listal.cpp. El archivo
cabezera: Listah.h y el proyecto (File | Save Project As) como: Lista.bpr. o .cbproj

= Poner icono: Para asignar un icono: (Project - Options » Application). Puls: Load Icon... - Seleccionar un icono.

= Temas en XE: Escoge (Project - Options - Application) - Appearance. Escoge: Rubi Graphite como el tema y pulsa Ok

Componentes de datos en el formulario principal:
En la paleta DbGO. Afiadir un componente ADOtable y un ADOConection por si necesitdramos mas tablas.
En la propiedad del ADOConectionl escoger: ConectionString - Build...

Proveedor | Conexidn | Avanzadas | Todas Proveedor | Conexidn | Avanzadas | Todas
Seleccione los datos a los que desea conectarse: Especifique lo siguiente para conectarse a datos de Access:
1. Seleccione o escriba el nombre de una base de datos:
Proveedores de OLE DB - — S .
Tiorosoft Jot 2.0 OLE DB Provider :I s\RAD Studio“Projects"C++buildertListf*suarios mdb || ..
Microsoft Office 12.0 Access Database Engine OLE DB Provide 2. Escriba la informacidn para iniciar sesién en la base de datos:

Microsoft OLE DB Provider for Analysis Services 10.0
Micrazaft O F NR Provider far ONRC Nrvers

Mombre de usuario:

* En la tabla ADOTablel, asigna las propiedades: Conection a el - a9 " IableUsuarios TADOTo0e
ADOConection1, su TableName: Usuarios y su propiedad Name: - - ' Bropertes]
) 7 Yy prop ADCConnectiont’ Properties | Events _
TableUsuarios Clla'e oo l|connection ADOConnectionl
* Pulsa doble clic sobre tabla ADO TableUsuarios y escoge del ' dgop.~ |Name TableUsuarios
’ ~_ s . @99 ||TableName Usuarios
menu contextual: afiadir All fileds. TableUsuarios, | s e o i
= D | | t DataA ~ d Dat C b S DSUsuarios TDataSource ..
e la paleta DataAccess, afiade un Datasource. Cambia sus |1 [Auteat W[ Troe :
propiedades Name: DSUsuarios y Dataset :TableUsuarios - - =" lpataset TableUsuarios | -
- DSUsuarios . |Fpaplaq [v]True > o
oo | |Name DSUsuarios

Componentes de disefio

® De la paleta Win32 afiade un ToolBar y un StatusBar.
= De la paleta DataControls, afiade un DBGrid con su propiedad Align al cliente y un DBNavigator sobre la
toolBarl

= En ambos componentes le asignamos su propiedad Datasource a (R LAILE 3 LIEIR MK -
DSUsuarios. Id Mombre email

= Sobre el componente DbGridl pulsa doble click para abrir el |p 1 Juan juan@gm
editor de columnas y anadir todos los campos. 2 Pedro nedro@ht

= Activa la propiedad de la TableUsuarios a True para ver los datos 3 Luis {'E |=—|:;' Bgmai
en la tabla. Tablelsuarios ADOConnectionl DSUsuarios

Ejecuta y prueba (Run). Si todo es correcto, Guarda todo (File » Save All):
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Anadir botdn para filtrar usuarios: : . .
void _ fastcall TVentanaAgenda::FiltrarClick(...)
{
Este botdn filtrard la lista de usuarios para que sélo se vean los if (Filtrar->Down==True) {
usuarios de t|po 0 Filtrar->Down=False ;
TableUsuarios->Filtered=False;
}
else
Crear ventana de acceso autenticacion de usuario: { Filtrar->Down=True;
Continuando con el ejercicio anterior: TableUsuarios->Filter="tlpo=0";
: , TableUsuarios->Filtered=True;
Para crear la ventana de acceso, disponemos de dos métodos: }
Utilizar una plantilla o formulario predefinido llamado } Password Dialog e
Passwordbialog Usuarior oIl
. o . o -
o crear un nuevo formulario en blanco y afiadir dos e(.ilts. ' Name EditUsuario 3
= Para crear la ventana de acceso, escoge desde la plantilla: :?I ............. & 9]
Olawes: - - - -« oo e

File — New — Other: C++ Builder files: PasswordDialog. L ]
Se mostrara una ventana de acceso a la que le afiadiremos (copiando y pegando) i

las variaciones de la imagen contigua. jooaconas Cancel

= Afiade el codigo al botdn cancelar: Application->Terminate(); O ey b s e
= Para incluir la UNIDAD (Unit) de la otra ventana, escoger del menu: File - Use Unit,

= Afadira al codigo: #include "PassWord.h" ver que al final este seleccionada la opcion header

Véase: http://www.programacionfacil.com/cpp builder

= Luego afiadir al evento OnShow de nuestro formulario principal (no OnCreate): PasswordDlg->ShowModal();

= En el botdn OK de la ventana Password:

if (EditUsuario->Text!=Dm->TableAjustesUser->Value) //Usuario=usuario
{ShowMessage("E1l usuario es incorrecto");
if (EditClave->Text!=Dm->TableAjustesPassword->Value) //Contrasefia=contrasena
{ ShowMessage("La contrasefia es incorrecta");}

else {VentanaClave->Close(); }

Agenda/usuarios: Acceso a tablas MYSQL en la red local por FireDAC

Crear la base de datos (Agenda) y la primera tabla (usuarios) en Mysql.

1. Desde Xampp o Wampp, ejecuta el acceso directo al panel de control para comprobar que tienes activado los B
servicios Apache y MySQL. En caso contrario activalos pulsando el botén Start.

2. Pulsa en admin de Mysql del panel de control o desde tu navegador web (Chrome, Explorer, Mozilla...) escribe la
direccion: localhost o 127.0.0.1 /phpmyadmin
Localhost equivale a usar nuestra propia maquina local como servidor de nuestra pagina web. Es decir, emula la
direccion de nuestra web desde nuestro ordenador. 127.0.0.1 o localhost, son 2 formas de llamar a nuestra IP interna, o
local (mediante la IP o mediante un dominio especial). Esta IP es especial, sirve para que un PC acceda a si mismo.

Para acceder desde otro PC de nuestra LAN: Tenemos que decirle a nuestro archivo host, que redirija la conexidon al PC que
tiene el servidor (como 127.0.0.1 hace referencia al propio PC, no podemos usar la misma). En este caso, debemos usar
la IP que el PC servidor tiene dentro de nuestra LAN: IP_Servidor_en_LAN dominio

3. En el panel de navegacion izquierdo de la pagina, pulsa sobre: PhpMyAdmin. # Nombre Tipo Nulo Extra
Otra manera de acceder, es escribir directamente, la direccidn: 1id int(4) No AUTO_INCI
localhost/phpmyadmin. 2 Nom  varchar(100) Si
4. Crea la base de datos: Agenda y la tabla Usuarios con los campos que se
muestran en la imagen. 3 email  varchar(100) Si
Opcional: Puede pulsar en Insertar y afiadir un registro de prueba o ejecutar la SQL: 4 clave  varchar(60) Si
INSERT INTO “agenda’. usuarios’ (‘id", 'Nom®, ‘email’, “clave’, ‘tipo’)
P - " Ay 5 tipo smallint(1)  Si
VALUES ('1', 'Edu’, 'edu@edu.es’, '1234', '0');
Crear la conexion y controles de acceso a los datos en el formulario.
Nota: Debes tener en una carpeta accesible (system o en la del proyecto) el archivo: (& Agenda
libmysal.d S
= Crea una nueva aplicacién VCL escogiendo del mend: File - New — VCL Form Applicaton C++ SEEE G B }Id 1 Uls;am
Builder. e 2 edu
= Afiade los componentes de la imagen adjunta. -
En FDConectionl: generar la conexion con el driver Mysq|l, teniendo el servicio Xamp activo. - FDConnection1’
Database: Agenda Host: localhost, User: root R
En TableUsuarios: Conexion: FDConectionl; Table name: Usuarios o EE
En DataUsuarios: Dataset: TableUsuarios. - TETEE T
En dbgrid: Datasource: DataUsuarios. Bl

= Comprueba, ejecutando la aplicacion y guardala. - *Datallsuarios * -
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Agenda/usuarios: Acceso a tablas SQLite en la red local por FireDAC (vCL)

Crear la base de datos (Agenda) y la primera tabla (usuarios) en sqlite.

Podemos crear la base de datos graficamente con el complemento SQLite Manager de Firefox: firefox/addon/sglite-
manager o hacer una tabla sencilla directamente desde el Dbexpress del DataExplorer de Embarcadero .

Crear la base de datos (Firefox — SqliteManager u otro)

Una vez instalado. Vamos a Firefox. Pulsamos Alt para acceder al menu Herramientas y elegimos SQliteManager.
Escogemos: Base de datos- Nueva base de datos. Ponemos el nombre Agenda y escogemos la carpeta del proyecto de
embarcadero para guardarla.

Escogemos: Tabla — Crear tabla. Y afiadimos los MNembre Columna  Tipo Datos Clave Prirnaria? Autoinc? Permitir Null?  Unica?
campos de la imagen. id INTEGER v Si si s

Nom VARCHAR ~| [ si Si Si
email VARCHAR ~| [ si Si Si

Crear la base de datos desde el IDE de clave VARCHAR v Osi 5i Si
embarcadero. tipo INTEGER v| Osi Si Si
= Enla ventana/panel Dataexplorer, seleccionamos el controlador dbExpress. +- @0 FireDAC
= Pulsamos el botén derecho del mouse sobre Sglite y escogemos: Add New conection. = B0 dbbxpress
Nombre: conexionagenda =@ AsA
= Pulsamos el botén derecho del mouse sobre la nueva conexidn y escogemos: Modify =@ Sqlite .
= Pulsamos el botén: Advanced y ponemos la ruta a la base de datos y cambiamos: Failifmissing 9% "fﬁg:genda
a false. Refrescamos la conexién para que se actualice. ; Views
= Expandimos la nueva conexion y pulsamos el botén Property Value R B—
Database s\Embarcadero'\Studio\Projects\Basesdatos\agenda. sl
derecho del mouse sobre Tables: New table. Driverame sqite
Afiadimos los campos de la imagen y guardamos la tabla. DriverPackageLoader TDEXSgliteDriverLoader, DEXSqliteDriver 240.bpl
MName Data Type Precision  Scale Mullable Primary Driverlnit Data.DbxSglite
'd INTEGER - 10 0 L FaillfMissing False
Nom TEXT v 100 0 O
email TEXT “ 100 0 [0 Guardamos la tabla con el nombre: usuarios.
clave TEXT “ 100 0 Il
tipo INTEGER 1 0 O
Crear la conexion y controles de acceso a los datos en el formulario.
= Afade los componentes de la imagen adjunta. @ Agenda Parameter value
= Enlaconexién: FDConectionl, pulsa doble clic sobre el o
componente para establecer las propiedades de la conexién: SEERNE-1 e ’Id 1 UIZ:‘W Pooled False
Ponemos el driver para SQlite. pRCT e 2 eqy | Database 3\abenda.salite,
En Database, abrimos la base de datos anterior. 2anc el s User_Name
En LockingMode lo ponemos en normal en lugar de exclusiva para - FDConnection1 Password
poder cambiar datos aun estando abierta y SharedCache mejor en RN MnitorBy
False. E - OpenMode CreateUTFa
En las propiedades de FDConection1: LoginPrompt = false y sl i, Enaypt o
Conected = true. R BusyTimeout 10000
* Enla TableUsuarios(FDTable): TableName= Usuarios. Active=true - “Datallsuarios " - | ¢ Cachesize 10000

= En DataUsuarios (DataSource): Dataset=TableUsuarios e e = Shrdca?e False
= En DBNavigator: Datasource= DataUsuarios. ocHnarions
= En DBGrid: Datasource= DataUsuarios. Pulsa doble clic sobre el componente para abrir el editor de columnas. Con el
botdn derecho del mouse, afiade todos los campos (All Fileds). Luego selcciona cada uno de ellos para ajustar el ancho
(width) mas adecuado a cada uno. Si tienes la libreria Jedy instalada, puedes cambiar por JVDBGrid, que permite
ademas las propiedades autoSize y autoSort.
Corre el programa y comprueba si es posible afiadir registros [+] con el DBnavigator.
Ampliacion: Conexién en tiempo de ejecucion
Anula las propiedades de conexion de la FDConectionl. Afiade un botdn de conexidn.
El evento al hacer clic: void _ fastcall TForm4::BConectarClick(TObject *Sender)
FDConnectionl->Params->DriverID="SQLite";
FDConnectionl->Params->Database="C:\ . . . \Agenda.sqlite";
FDConnectionl->Connected=True;
if (FDConnectionl->Connected==True) {
TableUsuarios->Active=False;
TableUsuarios->Connection=FDConnectionl;

TableUsuarios->TableName="usuarios";
TableUsuarios->Active=True;
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Acceso a base de datos SQlite desde aplicacion mévil. Lista de tareas. FMX
A partir de RAD Studio Xe6, se suele adjuntar una aplicacién de ejemplo en

la carpeta: Samples. Puedes enlazar el listbox con el campo visualmente I 5¢ pelete saLite +
desde el disefio visual liveBindigs: | 3 o
void __ fastcall TSQLiteForm::FormCreate(TObject *Sender) T b
{ asklist Ol DataSetTask SQLQuerylnsert
try {
TaskList->Connected = true; BindSourceDBl o o
SQLDataSetTask->Active = true; BindingsList1 SQLQueryDelete

LinkFillControlToFieldl->BindList->FillList();

}
catch (Exception &e) { _

ShowMessage(e.Message); SelectedValue
}
}/ ) m e mm e Synch
[tem. Text
void _ fastcall TSQLiteForm::btnAddClick(TObject *Sender) { e Detail _
String TaskName; m.oeE TaskName(lnvalid)
try { [tem.Bitmap
if ((InputQuery("Entre tarea", "Tareas", TaskName)) &&
(! (Trim(TaskName) == ""))) { ltem.Accessory
SQLQueryInsert->ParamByName("TaskName")->AsString = [tem.LookupData
TaskName;
SQLQueryInsert->ExecSQL(); e |eacd el
SQLDataSetTask->Refresh(); ltemHeader. Break

LinkFillControlToField1l->BindList->FillList(); _
}
}

catch (Exception &e) {
ShowMessage(e.Message);

}
3 = e e e e e oo
void _ fastcall TSQLiteForm::btnDeleteClick(TObject *Sender)
{
String TaskName = ListBox1->Selected->Text;
try {
SQLQueryDelete->ParamByName("TaskName")->AsString = TaskName;
SQLQueryDelete->ExecSQL();
SQLDataSetTask->Refresh();
LinkFillControlToFieldl->BindList->FillList();
if ((ListBox1l->Selected) && (ListBox1l->Count > 9))
// Select last item
ListBox1l->ItemIndex = ListBox1->Count - 1;
}
catch (Exception &e) {
ShowMessage(e.Message);
}
}
LA e R T T

void __ fastcall TSQLiteForm::TaskListBeforeConnect(TObject *Sender)

{
#if defined(TARGET_OS_IPHONE) || defined(TARGET_IPHONE_SIMULATOR) || defined(__ANDROID_ )
TaskList->Params->Values["Database"] = IncludeTrailingPathDelimiter(
System::Ioutils::TPath::GetDocumentsPath()) + "tasks.s3db";
#telse
TaskList->Params->Values["Database"] = "tasks.s3db";
#endif

void _ fastcall TSQLiteForm::TaskListAfterConnect(TObject *Sender)
{
TaskList->ExecuteDirect("CREATE TABLE IF NOT EXISTS Task (TaskName TEXT NOT NULL)");

En el string del SQLQuerylnsert:  insert into task (TaskName) values (:TaskName)
En el string del SQLQueryDelete: delete from task where TaskName = (:TaskName)
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EJERCICIO BASE DE DATOS CON C++ Builder y ADO — Control bancario de ahorros
Creacion de la base de datos y las tablas con MySQL

Creacion de la base de datos

1. Unavezinstalado Xampp o Wampp, ejecuta el acceso directo al panel
de control para comprobar que tienes activado los servicios Apache y
MySQL. En caso contrario activalos pulsando el botdn Start.

2. Ejecuta tu navegador web (Chrome, Explorer,
Mozilla...) y escribe en el cuadro de la direccién:
localhost
Accederas a la pagina de presentacién de Xampp.
Localhost equivale a usar nuestra propia maquina local
como servidor de nuestra pagina web. Es decir, emula
la direccion de nuestra web desde nuestro ordenador.

3. En el panel de navegacidn izquierdo de la pagina, pulsa
sobre: PhpMyAdmin.

Otra manera de acceder, es escribir directamente, la
direccion: localhost/phpmyadmin

"
Nota: la carpeta virtual localhost quedard localizado normalmente en: C:\xampp\htdocs

4. Pulsa en Base de datos. Luego escribe en el cuadro de
Crear base de datos el nombre: Bancos. Escoge un
cotejamiento para el juego de caracteres tipo Unicode
utf8_spanish o similar, para evitar luego problemas
con los acentos y la fi, como la imagen y pulsa el botén

Crear.

& Crear base de datos g
Crear

Bancos | utfd_spanish_ci '|

XAMPP Control Panel v3.0.12
Modules

Service Module PID(s)

1508

Port(s) Actions

Stop

Apache 80, 443

MySQL 436 3306
FileZilla Start

Mercury Start

x| xS &

£3

'(

Tomcat Start

it [ localhost/xampp/
') XAMPP 1.8.0 - Mozilla Firefox

€« c

Compone

chrenk  Lesesskhen  Extezs Hife

[x]

Catel  Eearbeiten
| Elxamre 1.0
& O beahostixarpp

[Z) XAMPP fiir Windov
NIYSUL-LUSTennank [ARTIVIER]

erwa XAMPP Control Panel v3.

Binthythmus Modul

Inskant Art ‘ofe.?& Modul  PID(s)
L

finsicht

Port(s)
] Apache az24 80, 443

ﬁ MysSQL 4172 3306

= C & [ localhost/phpmyadmin/
& Centro de Formacio... youtube - Buscar co... Google

p h p £l localhost

|| Bases de datos
& @ 00 @

f s localhost [ localhost | php = X

La base de datos Bancos contendra tres tablas: una para las libretas de ahorros, con los datos del titular. Otra
tabla servira para las operaciones en las libretas y la tercera tabla contendra los apuntes realizados en todas las
libretas, asociando cada apunte con su libreta mediante una relaciéon entre campos.

Escoge Crear Tabla con los siguientes campos:

%g Crear tabla

Tabla Columna Tipo Significado
Libretas Codigo Int - Primary Key £ Numero que identifica a la libreta
Titular VarChar(35) El titular de la libreta
Descripcion VarChar(35) Descripcién de la libreta
Saldo Int Redundante
Apuntes Int Redundante
Fecha datetime Redundante
Operaciones Codigo Int - Primary Key £ Un cddigo numérico de operacion
Descripcion VarChar(30) La descripcion de la operacion
Ingreso Char ¢Es uningreso o un reintegro?
Apuntes Libreta Int El cédigo de la libreta a la que pertenece el apunte
Numero Int Numero secuencial dentro de la libreta
Fecha datetime La fecha del apunte
Operacion Int El cadigo de la operacion
Importe Int El importe de la operacion
Saldo Int Saldo en el momento de la operacién
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Para facilitar la verificacién de las reglas de consistencia observa que hemos afiadido los siguientes campos

redundantes al esquema:

Tabla Columna Significado

Libretas Apuntes Numero de apuntes en la libreta
Saldo Saldo acumulado
Fecha Fecha del dltimo apunte

Apuntes Saldo Saldo en el momento de la operacién

Crear la aplicacion:
= Elije del menu principal: File » New » VCL form Application.
= Preparar el driver mysql:

Copiar todos los archivos *.dll de la carpeta xampp/mysql/lib

a la carpeta de C:\Program Files (x86)\Embarcadero\RAD Studio\XX\bin

El mddulo de datos.

= Crea un formulario: New » Other » C++ Builder files- Datamodule. Llamalo DM. La configuracién de las conexiones
dependera del formato que se esté utilizando para los datos: InterBase, Oracle, MS SQL Server o MySq|l.

Métodos de conexion a la base de datos MySql:

= Método utilizando el conector dbxExpress:

Con los servicios Xampp iniciados, afiadir al formulario el componente

SQLConection de la paleta dbxExpress

En sus propiedades, seleccionar el driver MySQL con los valores de la

imagen. Activar la propiedad Conected = XITrue.

Si no conecta es que algo va mal. En ese caso, deberds tener la libreria
mysql en una carpeta accesible por el programa: Busca el archivo:

xampp\mysql\libmysql.dIl y cépialo en la carpeta Bin de Embarcadero.

= Meétodo utilizando el conector ODBC:

SQLConnectionl | | | | 1

m‘ Events | SQLConnectionl. | [
ConnectionMame | MySQLConnection ~
Driver MySQL =7

BlobSize -1

Compressed [TFalse

Database bancos

Encrypted [ False

Hostiame localhost

Password

ServerCharSet

UserMame root

En primer lugar, acceder a la pagina de mysql.com y en Products — Conectors, descargar el driver ODBC para
Windows, para vuestra version de 32 o 64 bits. Una vez descargado, instalarlo en el equipo.

En segundo lugar, acceder a las herramientas administrativas del panel de control de Windows y , en
origenes de datos, agregar una nueva conexion seleccionando el controlador MySQL e introducir los valores
de laimagen. Pulsa en Test para comprobar que la conexidn es satisfactoria.

==2>C A |_L|\«'\Mw.mysql‘com_.-':nrc-d\.cts_.:"cc-w-wectc-r_;‘l R
! -com Downloads (GA) M}L LIL

Products Services Partners Customers Why MySQL? News & Events How to §

AN MysQL Connectors

MySQL Editions

The world's most popular open sour

MySQL provides standards-based drivers for JDBC, ODBC, and .Net en
MySQL Enterprise Edition library allows developers to embed MySQL directly into their applicatio
Datasheet (PDF)

Developed by MySQL

Technical Specification

MySQL Database ADOQ.NET Driver for MySQL (Connector/NET)

Enterprise Monitor
QODBC Driver for MySQL (Connector/ODBC)

Enterprise Backup

n

wr/ODBC

1 Parameters

rce Name:
esdiption:
{IP Server:
amed Pipe:

User:

Password:

Database:

conexion_mysqgl
conecon por ODBC estandar

localhost Port: | 3306

root

= [

bancos
cdcol

Volver al IDE del programa, buscar la paleta DbGO. Afiadir un componente ADOtable y un ADOConection al
formulario. Si sélo fuésemos a utilizar una tabla, podriamos afiadir la Conectionstring directamente en la
AdoTable. Pero como utilizaremos tres tablas, utilizaremos el componente ADOConection para introducir la

cadena de conexidn.
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Sl g : - ;
AT ObjectIns - - ADOL - - | DM.ADOConnection1 ConnectionString
. _— e ] - - -
Escoger: ADOCoNNection, o reactiont’  Source of Connection | ] Propiedades de vinculo de datos |
ConectionString Properties | Events (") Use Data Link File —
7| Attributes i Proveedor | Conexidn | Avanzadas | Todas
Build...
gz;nrl;l;i:ed'dﬁmeout@lse Especifigue lo siguiente para conectarse a datos ODBC:
Conexion % | Connectionstring ___..-'.JSE C-onnectlon String 1. Especifique &l origen de datos:
Usar el origen de ConnectionTimeout | 15 Provider =M5DASQL., sar &l nombre del origen de datos
ConnectOptions  |coConnectUr conexion_mysal w | | Actualizar
datos CursorLocation dUseClient i
DefaultDatsbase () Usar la cadena de conexidn
IsolationLewvel iICursorStabil
Kaannnnar Her [l Tria (e

= Escoge el origen de datos de la conexién_mysql creada anteriormente: conexion_mysql
= Desactiva el LoginPromt para que no nos pida el user y activar la propiedad Conected = XlTrue.
Si no conecta es que algo va mal.

TablasADO:

* Selecciona la ADOTablel e Introduce las propiedades de la imagen. [Fropertes| ThApuntes TADCTable
Name: TbApuntes Tablename: Apuntes > Active [ True -

» Copia la tabla dos veces cambiando los nombre y tablas: : gzﬁi‘iig‘:'ds Dggznnedhnl
Name: TbOperaciones Tablename: Operaciones Name Thapuntes
Name: ThLibretas Tablename: Libretas i:;:g:::’ct E::::

= Pulsa doble clic sobre cada tabla ADO y escoge del menu contextual:  |Tablemame apuntes

afiadir All fileds.
Datasources:

= De la paleta DataAccess, anade tres componentes Datasource apuntando cada Dataset una a su respectiva

tabla: o .
coo RS REel o Roel o [Roel .
DSApuntes dataset: TbApuntes. ﬁ ----- ----- ..

DSOperaciones dataset: TbOperaciones. A N R - e W
DSLibretas dataset: TbLibretas. e P Sl P St
L DsApuntes. DSOperadones DSLibretas
Relaciones:
Establecemos una relacién master/detail desde la tabla de libretas hacia la tabla de apuntes
IndexFieldMames | Libreta;Numero Propiedad Valor
IndexMame
MasterFields Codigo Name tbApuntes
I{MasterSource D5SLibretas TableName Apuntes
TableMName apuntes MasterSource DSLibretas
La propiedad IndexFieldNames, han concatenado los campos MasterFields Codigo
Libreta y Numero, para que la tabla de detalles quede ordenada |,4exFieldNames Libreta:-Numero

efectivamente por el nimero de los apuntes.
Disefo del Form Principal:

La ventana principal sera una ventana SDI, que mostrard los apuntes correspondientes a una libreta

seleccionada.

Proximo ejercicio: Test de preguntas y respuestas con Firedac para multidevice



